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Overview of HelpMatics™

1.1 Introduction

HelpMatics™ is a service management system for the IT helpdesk and other service departments.
This tool helps companies to efficiently organize incident and problem management and the
associated support workflow.

In addition to ticket processing, HelpMatics™ offers many other functions such as documentation,
information management and online reporting. Further features are its multi-client capability and the
support of QM processes by an integrated knowledge management.

The special advantage of HelpMatics™ is its intuitive handling in any workflow, ergonomic frontends,
equal structure in all modules, comparatively easy implementation and administration, optimal
transparency and continuous traceability in the support.

Our main objective during development was and is to combine maximum functionality with minimum
operating effort. Many advantages will only manifest themselves during the daily work with
HelpMatics™, which is confirmed again and again by our customers.

This documentation will acquaint you step by step with the use of HelpMatics™.

We hope that you will work efficiently with HelpMatics ™.
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1.2 Overview of features

The following overview shows you the services and functions offered by HelpMatics™ ServiceDesk
and HelpMatics™ Knowledge:

Incident Management

Prioritization, categorization, status, deadline monitoring, creation of histories, creation of
ticket templates for standard tickets, automatic transfer of e-mails into tickets etc. ensure
effective and fast processing.

Problem Management
Option of opening problem tickets, separate problem reporting.

Resource management
User and configuration item and/or config. item management (user, hardware, software,
documentation, service). Supports the import from or connection to existing systems.

Workflow Management
Forwarding, group and processing management, option of integrating Notes Mail or MS
Exchange possible.

Escalation management
Escalates according to the underlying SLA (Service Level Agreement); in addition, warning
levels can be individually configured as specified by the underlying SLA

Knowledge Management
Easy generation and use of an integrated knowledge base

Information Management
Central distribution of information, e.g. for changes, info display with the latest messages

Multi-client capability
Definition of clients for companies, locations, departments with individual SLA’s, client-specific
ticket processing and reporting

Web front-end

Ticket input screen for the Web and HelpMatics™ operation via a Web browser, e.g. for on-
site support team members

Languages

Available in different language versions; easily expandable to any languages you like
HelpMatics™ CMS

HelpMatics™ CMS offers enhanced functions regarding Configuration Management according
to ITIL. These features are described in a separate documentation. They are referred to at the
respective points of this documentation.

Enterprise functionality
Special versions support global support structures by the option of specifying the availability of
tickets, master data, SLAs, etc.

1.3 HelpMatics™ standard and SMB version

HelpMatics™ is available in a standard version and in an SMB version with limited features.
The limitations of the SMB version are described in a separate document.
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1.4 Using HelpMatics™ Enterprise

HelpMatics™ has been designed for global support of several sites and distributed teams.

This permits a differentiation in the replication of tickets, configurations and their effective control over
various support areas.

The standard version making use of the Enterprise setup is recommended for decentralized support at
companies with several sites.

Instructions applying only to the use of the Enterprise features are highlighted in this manual as
follows:

— —
ENTERPRISE:
— —

1.5 HelpMatics™ CMS Enterprise

HelpMatics™ CMS Enterprise, a Configuration Management System of the HelpMatics™ Suite, uses
a relational database managment system (RDBMS) for data storage.

The features that are exclusively available in HelpMatics™ CMS Enterprise are marked as follows:

HELPMATICS™ CMS ENTERPRISE:
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2 Main view and navigation

2.1 Navigator

The Navigator permits the navigation within the

Service Management System. Depending on the selected level,
further information and selection fields will be displayed. You
navigate by mouse-click.

In addition to a possible selection on the Navigator, the desired
information is displayed in the Viewer.

The Navigator may also be displayed differently, depending on the Resources
rights assigned. User
Config. items
Tickets
User
Config. items
Problems
Status
Client monitoring
Editor monitoring
Process editor
Team
Responsibility
Dates
Calendar
Tickets (my own)
Process editor
Team
Responsibility
Dates
E-mail drafts
My tasks
My search
Mail-in
Knowledge
Info management
Reporting
Administration
Help

Fig. 1: The Navigator

2.2 Viewer

The viewer represents the main window on the right where the information selected via the navigator
is displayed.

By clicking the column titles you can change the sorting order.
By double-clicking a line you can edit information and change it depending on the type of information.

The figure below displays the list of users including the respective sub-documents of the configuration
item (to be identified by the green arrow icon pointing to the bottom ¥). If the arrow points to the right

4 , the sub-categories are not displayed; you can display them by clicking the arrow. Via View >
Expand/Collapse > Expand all orCollapse all / View > Expand/Collapse > Expand all/Collapse all you
can display and hide the sub-documents of all entries, respectively.

COC AG HelpMatics™ ServiceDesk Seite 8



20158-08-05 14:49 Problem Exchange Server down
= Incident - Mew @kaet ﬁﬁssignediickets User—New mEquipmem f__ RFC/Change &Prim @Expuﬂ(e—mail]
= e
MName |User D -~ |F'hune (office) ~ |Rmm o~ |Building ~ |Department o~ |E—Ma\| - |Chent -~ man. -~
e Currie , Luce currie-lu +49 (030) 6645989 BER.101 AD1 Controlling COC Germany A
User Dow , Lula dow-lu +49 (089) 6645888 MUC.333 E21 Preduction COC Germany A
Config. items Dunkert , Paul dunker-pa +41 (D44) 8092734 7UE 065 AE1 Production COC Switzerland X
Tickets ad =L Holoer sizclsb-ho +40 (QOG77) S7470BGHI03  M30 Develgpment LOC Germany AX
User =PC: 1003 eizelsb-ho +49 (08677) 97475 BGH.103 M50 Development COC Germany A X
Config. items = Printer: 7001 eiselsb-ho +49 (08677) 97475 BGH.103 M50 Development COC Germany A X
Problems Gable , Darcie gable-ga +49 (0517) 654523 HAN.102 HO1 Production COC Germany A
Status Gant, Lisa gant-li +43 (01) 5678921 VIE 102 cm Production COC Austria AG X
Client monitoring Glidden , Ainsley glidden-ai +49 (0517) 654523 HAN.265 HO1 IT COC Germany A
Editor menitering Grosberg , Rudy grosbe-ru +49 (030) 6545342 BGH.205 M50 Preduction COC Germany A
Process editor Guszon , Peter gusson-pe +43 (07) 5678921 VIE.D11 co; Controlling COC Austria AG X
Team Hart, Ronny hart-ra +43 (01) 5678921 VIE.D23 cm Production COC Austria AG X
Responsibility Havlachek , John havlac-jo +49 (030) B[;$5789 BER.231 A2 Production COC Germany A
Dates Hazen , Bob hazen-bo +49 (0511) 654523 HAN. 345 HO1 Production COC Germany A
Calendar Hell, Robert hell-ro +43 (01) 5678821 VIE.102 co Production COC Austria AG X
fismy (=] Hemple . Rowan hemple-o  +49 (030) 6545870 BER.342 A0 Iy COC Germany A
b Hobart, Samuel hobert-sa +41 (044) 8092734 ZUE.045 AE1 Marketing COC Switzerland X
Responsibility Hobbes . Thomas hobbes-to +49 (030) 6545234 BER.345 AD1 Controlling COC Germany A
Dates Hoed , Robin heood-ro +45 (08677) 97473 BGH.123 M50 Purchase COC Germany A
E-mail drafts Inman . Dooley inman-do +49 (040) 6545896 HAM.023 BO1 Production COC Germany A
My tasks B Irm , Peter irm-pe +45 (08677) 97475 BGH.234 M50 IT COC Germany A X
My search Isabelle . Leo isabel-le +49 (040) 6545236 HAM. 223 BO1 Production COC Germany A
Mail-In b Jackel  Eva jackel-ev +45 (08677) 97478 BGH.202 M50 Controlling COC Germany A X
Knowledge Jones . Ed jones-ed +49 (0511) 654578 HAN.034 HO1 Taining COC Germany A
Info management Kerry, Susan kerry-su +43 (01) 5678921 VIE.034 co1 Marketing COC Austria AG X
Reporting Kiley . Richard kiley-ri +49 (040) 6545342 HAM.345 BO1 Management COC Germany A
Administration King , Ros king-ro +45 (040) 6545298 HAM.453 BO2 Training COC Germany A
Help Kurtr Petra kuirtz-ne +41 (N44) ANG2734 71IF 029 AF1 Praduction COC Switzerland X
= s SRR = B SEERRT

Figure 2 The viewer

Note:

In the man. column on the right of the Viewer the manually created users and/or config. items are marked.
If the mark is missing, the data have been imported.

Moreover, you can sort the data in the Viewer by columns in ascending or descending order by
clicking the black triangle in the column title. Quick search: This convenient standard feature of HCL
Notes allows you to quickly navigate to the requested data:

If, e.g., you want to create a ticket for a user, simply enter the user's name or initial letters via the
keyboard. This automatically opens a window:

Find [ x|

By clicking OK, the user searched for will be highlighted

i [ ¥ and you can create the ticket.
Starts with || |

More Options...

Please note: The quick search is always performed in the first sorted column. In the case of
categorized views, this is the first category level.

COC AG HelpMatics™ ServiceDesk Seite 9
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2.3 Action bar

Depending on the view selected in the navigator and the level of rights, you see different buttons on
the action bar. You open a ticket in the list view via double-click.

Inudent- New Ticket RFC /Change ‘9 Reopen b Print
Ty -~ o - -
— = -

Fig. 3: Action bar
2.4 Iconsin the views
Icons play an important role in the views of HelpMatics™ since they I w= 27n204
display information in a compressed way. In order to work efficiently with o 20022014
HelpMatics™, you should first memorize the mostly self-explaining icons. B o 20022014
When you hover over an icon a brief explanation appears. The following B o= 208122013
tables explain the icons used as well as their meaning. I o= 06122013

COC AG HelpMatics™ ServiceDesk Seite 10



2.4.1 Priority

The priorities are transferred according to the settings under ADMINISTRATION > CLIENTS > DEFINITION.

Icon Meaning
Priority 1 & Suggestion: asap
Priority 2 + Suggestion: very high
Priority 3 - Suggestion: high
Priority 4 - Suggestion: Standard
Priority 5 + Suggestion: low

2.4.2 Forwarding and returning tickets

Forward Icon Meaning

Workflow > Process editor o forward to process editor
Workflow > Process team or process team

Workflow > Back to resp. person/team ] closed / user informed
Workflow > Back to resp. person/team i closed / user not informed
Workflow > Back to resp. person/team k] further processing required
Workflow > Back to resp. person/team ol incorrect ticket assignment
2.4.3 Automatic mail processing

Action Icon Meaning

Mail from Mail-In automatically attached to ) - E-mail attached to the ticket and process
the ticket editor informed, if required.
2.4.4 Status

Status Icon Color

closed - green

work in progress yellow

open L+ red

on hold L violet

assigned external @ blue

scheduled ticket & grey

COC AG

HelpMatics™ ServiceDesk

Seite 11



Holp-Maki<a

2.4.5 Date

Date Icon

phone: e.g. call-back date
fax / mail: response by fax or e-mail

on site: e.g. appointment with user

@ ¥ @ @

reminder

2.4.6 Ticket type

Icon Meaning
] master ticket or master info
t sub-ticket
Pl problem ticket
m Incident ticket

Service requests are displayed without an
icon.

COC AG HelpMatics™ ServiceDesk Seite 12
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3 Resource management

HELPMATICS™ CMS ENTERPRISE:
If you are using HelpMatics™ CMS, please refer to the HelpMatics™ CMS documentation for resource

management.

3.1

L Makiss

User

Ig.lnddenl - New Ticket @Assigned tickets &jUser - New %‘ﬂEquipmenl RFC/Change ,;Print L@g Export (e-mail)
.
S h in View 'R \User"
Resources Search for I
User = - :
Tiglo(::‘:. ftems Name |UserID ~ |Phone (office) ~  |Room ~ |Building ~ iDepartment ~ |E-Mail ~ Client ~ |man. ~
User L_Aonelli Sabrina 11 +41 (044) 8092734 ZUE 023 AE1 Production 2 i
Config. items Allison , Gaby alliso-ga +43(01) 5678921 VIE.104 Cco1 Training COC Austria AG X
Problems Arbuckle . Ron arbuck-ro +49 (089) 6645324 MUC.24 E21 Executive COC Germany A
Status » Backel , Jules backel-ju +41 (044) 8092734 ZUE.089 AE1 Executive COC Switzerlanc X
Client monitoring » Barbeiss , Barbel baerbe-ba +49 (089) 6645101 MUC.103 E24 Training development COC Germany A X
Editor monitoring Beere , Johannes jbeere +49 8677 9747 0 development COC Germany A X
Process editor Berg . Jacob berg-ja +49 (089) 6601234 MUC.012 E21 Controlling COC Germany A
Team .. » Bingo . Peter bingo-pe +49 (089) 66451492 MUC.102 E21 Project COC Germany A X
Responsibility » Blass , Giinter blass-gu +49 (089) 66451011MUC.254 E24 Training development  COC Germany A X
Dates » Blinker, Hans birker-ha +49 (089) 6645323 MUC.342 E21 Controlling COC Germany A
Tiz:::"z:w own) Boston . Albert boston-al +43(01) 5678921 VIE.042 co1 Executive COC Austria AG X
Brones adiin Brandell , Kevin brande-ke +43(01) 5678921 VIE.023 co1 Marketing COC Austria AG X
: e Burg . Caspar burg-ca +49 173 346 9999 COC Germany A X
Responsibility b Carl, August carl-au +49 (08677) 974722 BGH.231 M50 Development COC Germany AX
Dates Churchill , Conrad winston-co +49 (030) 6645232 BER.231 AD2 Executive COC Germany A
E-mail drafts Currie , Luce currie-lu +49 (030) 6645989 BER.101 A01 Controlling COC Germany A
My tasks ¥ Dinkel , Susanne dinkel-su +49 (030) 4568558¢ BER.200 A02 Production development COC GermanyAX
My search Dow . Lula dow-lu +49 (089) 6645888 MUC.333 E21 Production COC Germany A
Mail-In Dunkert, Paul dunker-pa +41(044) 8092734 ZUE.065 AE1 Production COC Switzerlanc X
Knowledge b Eiselsberger . Holger eiselsb-ho +49 (08677) 974754 BGH.103 M50 Development COC Germany A X
Info management » Eugenstein . Sandra eugens-sa +49 (0511) 6645105 HAN.101 HO1 Management development COC Germany A X
Reporting Gable , Darcie gable-ga +49 (0511) 6545234 HAN.102 HO1 Production COC Germany A
Administration Gant, Lisa ganti +43(01) 5678921 VIE. 102 co1 Production COC Austria AG X
Help » Gelb . Friedhelm gelb-fr +49 (089) 66451014BGH.234 M50 Production alexander.bartel COC Germany A X
Glidden , Ainsley glidden-ai +49 (0511) 6545232 HAN.265 HO1 IT COC Germany A
Grau , Betty grau-be +49 (08677) 974745 BGH.456 M50 Production bg @coc-ag.de COC GermanyA X
Grosberg , Rudy grosbe-ru +49 (030) 6545342 BGH.205 M50 Production COC Germany A
Gusson , Peter gusson-pe +43(01) 5678921 VIE.0O11 Cco1 Controlling COC Austria AG X
Hart, Ronny hart-ro +43(01) 5678921 VIE.023 Cco1 Production COC Austria AG X
Havlachek .lohn havlac-in +49 (N30 AR4R729 RFR 231 AD2 Praduction COC Germanv A

Fig. 4: Navigator and Resources > User view

In the Navigator you can see the User navigation item below the RESOURCES category. By clicking

USER the corresponding view will be displayed in the Viewer.

This view displays all users supported by the helpdesk, sorted by the users' last names.

The green triangle symbolizes that a configuration item is assigned to this user.

Via the buttons of the action bar available in this view you can perform various actions.

@lncident- New Ticket

= Double-click to open a user in the list.

@Assignedtickets gUser-New l@quuipment

RFC /Change

\‘j Print

= In order to create a new ticket for a certain user in this list, select the user in the view and then
click the INCIDENT — NEW button.

= The ASSIGNED TICKETS button displays the tickets existing for a selected user in a separate
window. By double-clicking a ticket, you can directly go to the ticket.

=  With the USER - NEW button you can create a hew user.

A new window opens, in which you can enter the user data.

COC AG
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1. Enter the necessary data.

2. If you want to use a specific priority for each ticket created for a user, set the specified priority
to “Y” and select the desired priority via the button. This setting will be inherited to all assigned
configuration items.

3. Inthe CoOMPANY tab you have to assign a client to the user and can then enter further
company-specific data.

4. Subsequently, click the SAVE and CLOSE buttons.

c:giClose HSave @Address book @Inddent-New ?. Problem - New
—

User *%-—-

User ]Company ]

Name: ki Phone (office): E
First name: 2 Mobile: 5
Title: 2 Fax: =
User ID: e E-mail: b
Employee ID: b Flex-Field 1: 2
Position: 2 Specified priority: " Yes & No

Fig. 5: Screen for creating a new user

You can create new configuration items via the config. item button. Differentiation is made
between creating a configuration item not associated with a user (EQUIPMENT > NEW — SOLO), a
configuration item for a selected user (EQUIPMENT > New — to User) or a configuration item for an
already existing one (EQUIPMENT > NEW — TO CONFIG. ITEM) as a sub-configuration item.

A new window opens in which the configuration item data is entered.

With the EQUIPMENT > CHANGE assignment button (see fig. Fig. 6) you can easily change the
assignment of configuration items or assign them to another user.

To do so, first select the configuration item to be reassigned, and a small check mark will appear
to the left of it.

Then select the user the configuration item is to be assigned to in the same way.
Finally, click the EQUIPMENT > CHANGE ASSIGNMENT sub-action.

You can also change the assignment of several configuration items simultaneously. To do so,
select all configuration items concerned as well as the target user or the target configuration item.
If a definite assignment cannot be identified, a notice will be displayed.

In the figure below, the configuration item is now assigned to Agnelli, Sabrina.
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uAssignedtickets QUser-New jiﬁquuipmentv RFCIChange ffiaPrint @Expor‘t(e—mail)

B~y Incident - New Ticket

UserID « New - to User iman. ~

Name |Phone (office) ~  Roo it~ [E-Mail ~ Client ~

o aanell-sg +41 (044) 8092734 ZUE New - to Config. item COC Aystrig AG X
Allison , Gaby alliso-ga +43 (01) 5678921 VIE. New = sole COC Austria AG X

Arbuckle , Ron arbuck-ro +49 (089) 6645324 MUt o COC Germany A
» Backel . Jules backel-u +41(044) 8092734 ZUE ShnsEsopment COC Switzerlanc X
¥ Barbeiss , Barbel baerbe-ba +49 (089) 6645101 MUI Disassociate assignment development  COC Germany A X
v >PC: 1021 baerbe-ba +49 (089) 6645101 MUCT03 E2% Training development COC Germany A X
> Printer: 7002 baerbe-ba +49 (089) 6645101 MUC.103 E24 Training development  COC Germany A X

Berg . Jacob berg-ja +49 (089) 6601234 MUC.012 E21 Controlling COC Germany A

Fig. 6: Selection and sub-actions for changing the assignment of configuration items

In contrast to this, you can disassociate an assigned configuration item/sub-configuration item
from a user via EQUIPMENT > DISASSOCIATE ASSIGNMENT. Thus, sub-configuration items
automatically become normal configuration items again.

= If you are using HelpMatics™ Change, you can directly create RFC documents or Change
documents referring to the selected user data via the RFC / Change action, the appropriate
authorization provided. This action is available in other views, such as Tickets\User: In this
case references to the selected tickets will be integrated. The created documents can be
further edited in HelpMatics™ Change.
For quick documentation of changes the Quick CHANGE — NEWw action is available. For further
information on Quick Changes refer to the HelpMatics™ Change documentation.

3.2 Configuration item

The RESOURCES > CONFIG. ITEMS view displays all configuration items supported by the helpdesk,
arranged by configuration item numbers.

]
: > @Inddent - New Ticket aAssigned tickets %‘}Equipment RFC/Change “) Print
. :
h in View 'R E it

Resources Search for I
User
Config. items | 3 | T | g | 8

Tickets ‘Conﬁg, item No. _Catggory ~ |Model ~ :Soﬂware version ‘;Start of Ieasmglpurch ~ QUser ~ Client ~ |man. ~
User 01433SNELSON Workstation [not assigned] COC Germany AG
Config. items 01433SNELSON Workstation Win2k Backel, Jules COC Switzerland AG X
Problems 01458RPARRY Workstation [not assigned] COC Germany AG
Status 01511BMH Workstation [not assigned] COC Germany AG
C[K‘enl mom‘lorl.ng 01765JMOSER Workstation [not assigned] COC Germany AG
EaE monioring 01910SPLUM Workstation [not assigned] COC Germany AG
Process editor e
T 0711 TK Bartels, Alexander COC GermanyAG X
Responsibility 0308 Zubehor Ulmer, Ludwig COC GermanyAG X
Dates 1001 PC P3-800 WinXP 01.08.2001 Zaunkénig, Elmar COC GermanyAG X
Calendar 1002 PC P3-800 WinXP 01.08.2001 Schwerttrager, Sibill COC GermanyAG X

Tickets (my own) 1003 PC P3-800 Win2000 01.08.2001 Tasse, Micha COC Germany AG X
Process editor 1003 PC P3-800 Win2000 01.08.2001 Eiselsberger, Holger COC GermanyAG X
Team 1007 PC P3-800 WinNT4 01.08.2001 Gelb, Friedhelm COC GermanyAG X
S:fg”s'b""y 1010 PC P3-800 WinXP 01.08.2001 Brauer, Liselotte COC Germany AG X
el doaps 1011 PC P3-800 WinXP 01.08.2001 Dinkel, Susanne COC GermanyAG X
My tasks 1016 PC P3-800 Win2000 01.08.2001 Eugenstein, Sandra COC GermanyAG X
My search 1018 PC P3-800 WinNT4 01.08.2001 Hofer, Heinrich COC GermanyAG X

Fig. 7: Information on config. items
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Note:

HelpMatics™ allows you to store much more information on the configuration items than is
listed in the view and thus supports you in the resource management.

This view also allows you to perform various actions via the buttons of the action bar:

= With INCIDENT - NEW you can create a new incident ticket for the selected configuration item. In the
same way you can create a new problem ticket with the TICKET > PROBLEM - NEW (EMPTY) button.
The ASSIGNED TICKETS button shows you the tickets connected with the selected configuration
item. By double-clicking a ticket, you can directly go to the ticket.

Tickets conceming 01433SNELSON

N Createdon  Process editor User Brief description [ ok |
9= 01062018 Pfahl , Martha No user assigned| HM 13] Reset SAP S4 Password .
@ = 07072018 Beere , Johannes Backel, Jules [HM_13] Reset SAP R/3 Password @
@ = 27062018 Maus , Carl Backel, Jules [HM_13] Defect Printer Hardware
@ = 27062018 Auer , Anna Backel, Jules [HM_13] Windows 8: access violati
@ = 01062018 Urlaub , Farin Backel, Jules [HM_13] Access IBM Domino data
@ = 02052018 Pfahl , Martha Backel, Jules [HM_13] Lost Smartphone
@< 11042018  Etzler, Daniel Backel. Jules [HM_13] Wrong proxy server settin
@ = 04022018 Beere , Johannes Backel, Jules [HM_13] Reset SAP S4 Password

< >

4

Fig. 8: Assigned configuration items

= Via the NEwW — EQUIPMENT sub-action you can add a new configuration item (for how to create a
“solo” config. item, see above).

%Close HSave %Inddent-New F‘roblem-New

Equipment t} a
Equipment I Company I
P
Config. item No.: o Network-/IP address: Leasing/Purchase start: 18]
Type: e Hardware address: T Leasing/Purchase end:
Category: = Software version: E Contract period: o
Manufacturer: e Location 1: "E Leasing rate: s
Model: T Location 2: = Contract number: o5
Serial No.: fJ Mobile: ' Yes & No Order number: 5
Description: 2 Flex field 2: o Value: o
Flex field 1: & Flex field 3: 7% Delivery date: 16]

Fig. 9: Screen for creating configuration items

= In order to change the data of a configuration item of this list, select it in this view and click EDIT.

= If you are using HelpMatics™ Change, you can directly create RFC documents or Change
documents referring to the configuration item data via the RFC / Change action, the appropriate
authorization provided. These will be further edited in HelpMatics™ Change.
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4 Incident ticket recording

4.1 Assignment to Resources

A ticket is created on the basis of the user and configuration item data recorded in HelpMatics ™.

With the Incident — New button you can create a new incident ticket for the selected configuration item
or user.

4.2 Comparing data of existing tickets to resources data

If a new ticket is created on the basis of an existing one in the ticket views (INCIDENT — NEW OR TICKET
> INCIDENT — COPY), the user and configuration item data of the underlying ticket will be compared to
the resource data. This function is to ensure that the current resource data is used when a ticket is
created.

Comparison is made on the basis of the name (last name, first name). If several user documents with
the same name are found, search will be continued via user ID and e-mail. If exactly one user
document is found, the user data (green area) will be transferred from the resource document into the
ticket - if differences to the ticket have been determined.

Configuration items — if assigned - are searched for via the configuration item number. In case of an
unambiguous search result and data differences,
the configuration item data (blue area) will be transferred into the ticket.

If a new ticket (INCIDENT — NEW) is created, a data replication will be performed automatically without
the ticket creator being informed.

When creating a ticket copy (INCIDENT — COPY) the creator will be informed of data differences and can
decide on a data refresh in the ticket. The message displayed differentiates between user and
configuration item. This means that there may be two messages.
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4.3 Rapid recorder (rapid recording window)

TicketID: CAT-101011140844-CMa ]
TicketID: CAT-101011140844-CMa

Equipment/ Cl & Equipment (User) Existing tickets
[Mw345 " Cl (root cause) User J Equipment l

Brief description

Request
11.10.2010 14:08 (GMT + 1) from Claudia Mad|

Category

Ol | I ]
Type Prionity

[ _j[ ] 5 [slandard J
Process editor

[Madl . Claudia ] Person | Team l

Template/Solution-data transfer i )
Template O: Client Error | Templates |
Template 1: Configuration Standard Citrix —
Template 2: Intrusion alert auf Firewall - -
Template 3: Printer Error: Fuser defekt ¥ with Main G’MW
Template 4: Stérung Desktop PC: no keyboard found Search Solution |

Open problems |

Transfer data I

Fig. 10: Rapid Recorder

Note:

New ticket templates can be created via Administration in the Navigator.

The Rapid Recorder is a window for rapid recording of ticket data and appears prior to the actual ticket
window.

The ticket is automatically assigned on the basis of the user or configuration item selected before.

The Rapid Recorder facilitates data recording as it is clearly arranged and only contains the most
important fields. Other information that can also be entered later, e.g. after the phone call, will only
appear in the window for new tickets.

The rapid recording window is divided into the following areas:

43.1 Cls

Regarding the configuration items you can determine if they belong to the user or are the reason for
the creation of the ticket.

Beneath Existing tickets already existing tickets associated with the user or configuration item can be
viewed via a dialog list by clicking the USER OR EQUIPMENT BUTTON. This information allows you to
recognize recurring requests or faulty operations by users timely, or to complete already existing
tickets.
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4.3.2 Request

Enter a brief description and description of the problem or request there.

4.3.3 Category and process editor

The categories define the caller's request and facilitate the forwarding to experts.

By clicking the button next to Category you make your selection. Subcategories 1 and 2 depend on
their superior category, i.e. only if you select e.g. Software as main category, will MS Office be
displayed.

If you selected the wrong subcategory by mistake, you get back to the previously selected superior
category (main or subcategory 1) via the Cancel button and can correct your selection.

The category selection may influence the display of templates (see chapt. 4.3.4).

Choose a TYPE required for solving the request, e.g. installation or trouble shooting.

The Priority shows the urgency of a ticket. For every ticket a priority has to be set, which can be
chosen freely from a list via a dialog box. Exception: A specified priority has been defined for the user
in the user data. In this case the priority as stored in the user data will be set and will be clearly
identified as specified priority.

For the current ticket the default priority can be adapted to the process requirements by the process
editor. As a result, the ticket will no longer be identified as having a specified priority. If you create a
new ticket based on this ticket (e.g. in the TICKETS — USER view), no specified priority will be set.

The process editor may be a person or a group of people entered in the processor lists. If you click the
Person or Team button, you can select from the list of all process editors or teams.

4.3.4 Template selection / Solution data transfer

You can select a template in the bottom section (TEMPLATE/SOLUTION DATA TRANSFER).

The display of ticket templates may vary depending on the configuration. Ticket templates that only
apply to a certain client are only available for selection in tickets of the relevant client. The selected
user or the selected ticket forms the basis for the client of the new ticket.

Another criterion for the availability of ticket templates is the category: depending on the category
selected, a specific set of ticket templates will be available. You define the category also by taking
over a template and thus influence the templates displayed now. If, despite you have set a category,
the basic templates are offered, just click the Templates button.

You can perform a search in the knowledge base via the SEARCH SOLUTION button. The search will
consider the text of the short description (OR-operation) and the main category, if selected.

The OPEN PROBLEMS button allows you to extend the search to problems. The search comprises short
description and/or main category in various possible combinations.

Via the Transfer Data button, the selected template and/or the knowledge base entry or the problem
can be inserted into the current ticket.

The following data will be replaced:
- brief description
- Solution
- Processing (from template only)
- Root cause (from template only)
- Type (from template only)
- Category (from template only)
- Process editor/team (from template only)
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The following data will be added:
- Request

— —
ENTERPRISE:

The availability can already be set in the Rapid Recorder. However, a global category has to be
selected first. Only then will the button AVAILABILITY be displayed. You can select from the following
options:

LocAL (by default, in the current database only), CENTRAL (in local and global databases) and GLOBAL
(in all databases).

4.4 Ticket

In this window all data relating to a ticket is displayed.

A ticket has always to be assigned to a user or Cl. The ticket client results from this assignment. If a
user or Cl is assigned to a different client, it might be necessary to select a new category and priority.

::‘{icmse H save Skcategory & Worldiow aStatus Z[mail ([ Tools ./ Search amaster & Links %Aﬂachment 23 Print

Incident COC-150414154812-w94 Reset SAP R/3 Password
Type Senvice Request
Root cause Senvice User I Details Equipment
Category SAP Basic Name: Martha Pfahi =i @, Display
2 S ¢ User ID: "mpfahl 4 G Tickets
Brief description Reset SAP R/3 Password Phone (office): "+49 8677 97470 £ Reporter
Attachments: Position / Department: ™ /"
Client: COC Germany AG
> 5 o Cl (root cause) | Details Linked Cls
Request Work history | Solution Mail history
= = Clname: =
Q
[ New entry : 2 View : : Type / Category: BTy
+++ Authorisations only in compliance with the data policy +++ Manufacturer / Model: © ;/%
D iption: 5
SAP User: mpfahl g=dion 2
Module: MM
Mandant: DE Work status History Tickets
Priority: standard =i
Phone: +49 8677 9747 0 Status: new
Date: " not required ;=1
Responsibility | Processor list
Responsible personfteam Phone Client Department Deadline Monitor Proc [Min]
[Service Desk] +49(89)123456 COC Germany AG IT-Senvice 2015-04-15 14:48 (2]
Process editor / [Process team]
[SAP Basis Services] — COC Germany AG Development — 0 =
Screenshots:
-

Fig. 11: Ticket window

The ‘;-?" Template button is available in the action bar for new tickets that have not been saved

All templates available for the client are offered. If the category is also set, the category filter will be
applied. Click ALL TEMPLATES to remove the category filter. When you select a new template, the
existing values will be overwritten in the ticket, except for entries in the request, solution and edit
fields. Here, the texts from the new template will be entered at the end.
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4.4.1 Ticket information
E({iCIose HSave ‘*Category $Workﬁow aStatus " Zmail [ Tools \ Search &Master t:)Links %Aﬁachment ‘V‘Print

Incident COC-150414154812-w94 Reset SAP R/3 Password
Type Service Request
Root cause Senvice User ] Details Equipment
Category SAP Basic Name: Martha Pfahi = @ Display
> e 7 User ID: “mpfahl 3 Tickets
Brief description Reset SAP R/3 Password Phone (office): " +49 8677 97470 £ Reporter
Attachments: Position / Department: ™ ;17
Client: COC Germany AG
z = e Cl (root cause) | Details Linked Cls
Request Work history | Solution Mail history
= = Clname: =
i Newentry 4 View Type / Category: T
+++ Authorisations only in compliance with the data policy +++ Manufacturer / Model: ™ /%
St @
SAP User: mpfahl De=cipion: 2!
Module: MM
Mandant: DE Work status History Tickets
Priority: standard =i
Phone: +49 8677 9747 0 Status: new
Date: “not required =1
Responsibility | Processor list
Responsible personfteam Phone Client Department Deadline Monitor Proc [Min]
[Service Desk] +49(89)123456 COC Germany AG IT-Senvice 2015-04-15 14:48 (2]
Process editor / [Process team]
[SAP Basis Services] - COC Germany AG Development — o =

Screenshots:
7
]

Fig. 12: Ticket information

This area contains the information on ticket ID, brief description, categories and type of ticket which
you entered in the Rapid Recording window.

HELPMATICS™ CMS ENTERPRISE:

If you have selected a category to which one or more services are assigned, then this service will be
set and/or a selection being offered. The service is displayed below the category now. Using the
category-service button, you have an additional option for services. If a new service is selected, a
check is made as to whether the current ticket priority is identical with the service priority. If not, a
dialog window will be opened for selecting the priority.

If a service is removed from the ticket, the client’s service level will be used, and, if applicable, the
priority is to be newly selected.

For further information, refer to the HelpMatics™ CMS module documentation.

ENTERPRISE:

If you have selected a global category, you find the availability control below the brief description:
LocaL (by default, in the current database only), CENTRAL (in local and global databases) and GLOBAL
(in all databases).

In case the ticket is forwarded to a process editor of another client, relevant messages referring to the
change of availability will be displayed.

It is not possible to downgrade the availability (e.g. from global to local).
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4.4.2 User information
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Clicking the =l button you can change the assignment to a user. You can also modify the entries in
the fields. If, however, you change data in the User tab, the changes will only affect this ticket. To
change the user profile permanently, go to Resources/User, select the respective user and open the
user data with a double-click. Alternatively, you can open the user document from the ticket via the
Display button. Now click the EDIT button to change the data.

If you change the user to a user of a different client, the priority will be emptied. The priority values of
the new client will then be offered for selection.

You differentiate between reporting users and users causing the ticket.
Existing tickets concerning a specific user can be called via the TICKETS button.

q{iCIose HSave ‘,*Category SWorkﬂow a Status 7__—5}Mail @Too!s v Search SMaster @Links %Aﬂachment :?Print
Incident COC-150414154812-w94 Reset SAP R/3 Password
Type Service Request
Root cause Service User Details Equipment
Category SAP Basic Name: Martha Pfahl =1 @, Display
A e 5 UserID: " mpfahl 4 G Tickets
Brief description Reset SAP R/3 Password Phone (office): *+49 8677 97470 £ Reporter
Attachments: Position / Department. ™ ;/* |
Client: COC Germany AG
> s e Cl (root cause) | Details Linked Cls
Request Work history | Solution Mail history
= Clname: =
(~
[ New entry “A View Type I/ Category: Tl
+++ Authorisations only in compliance with the data policy +++ Manufacturer / Model: © /%
intinn: r
SAP User: mpfahl Resaiton 2!
Module: MM
Mandant: DE Work status | History Tickets
Priority: standard =i
Phone: +49 8677 9747 0 Status: new
Date: “not required ;¥
Responsibility | Processorlist |
Responsible personfteam Phone Client Department Deadline Monitor Proc [Min]
[Service Desk] +49(89)123456 COC Germany AG IT-Semvice 2015-04-15 14:48 8]
Process editor / [Process team]
[SAP Basis Services] o COC Germany AG Development — o =
Screenshots:
=
|
Fig. 13: User information
The config. item used by the user can be entered in the Configuration item tab.
COC AG HelpMatics™ ServiceDesk Seite 22




4.4.3 Cl (root cause) - Information
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C('iiCIose HSave ;.}g‘Category SWorkﬂow a Status | Z|Mail {ﬂTools  Search aMaster bLinks %Aﬁachment “‘?Print
Incident COC-150414154812-w94 Reset SAP R/3 Password
Type Senvice Request
Root cause Service User l Details Equipment
Category SAP Basic Name: Martha Pfahi =l @, Display
2 S P UserID: " mpfahl 4 3 Tickets
Brief description Reset SAP R/3 Password Phone (office): " +49 8677 97470 £ Reporter
Attachments: Position / Department. ™ ;/©
Client: COC Germany AG
> = = Cl (root cause) | Details Linked Cls
Request Work history | Solution Mail history
Z Q.. Clname: =
Ne.w entry : “S View : Type I Category: R
+++ Authorisations only in compliance with the data policy +++ Manufacturer / Model: © i I3 i
SHEAE o
SAP User: mpfahl Desamion 4
Module: MM
Mandant: DE Work status | History Tickets
Priority: standard =i
Phone: +49 8677 9747 0 Status: new
Date: "not required =
Responsibility | Processor list
Responsible personfteam Phone Client Department Deadline Monitor Proc [Min]
[Service Desk] +49(89)123456 COC Germany AG IT-Senvice 2015-04-15 14:48 e
Process editor / [Process team]
[SAP Basis Senvices] - COC Germany AG Development — o =

Screenshots:
I
1

Fig. 14: ClI (root cause) - Information

In incident tickets information on the CI causing the incident can be stored.

Clicking the =l button you can change the assignment by selecting a CI from the list offered.
Configuration item data will automatically be transferred into the corresponding fields. If a user has
already been assigned to the incident ticket, only configuration items belonging to this user will be
displayed in the list first. Click Cancel in the selection window if HelpMatics™ shall offer all

configuration items for selection.

Existing tickets concerning the CI can be called via the TICKETS button.

Several (different) configuration items can be assigned to incident and problem tickets. The desired
connections can be created via Links -> assign / disassociate config. items

The CI types USER, HARDWARE, SOFTWARE, DOCUMENTATION, GROUPS AND SERVICE are available when
the CMS module is used. Otherwise only equipment can be selected.
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4.4.4 Information on ticket processing (work status)

The WORK STATUS tab shows you the priority of a ticket. This can be changed, if necessary.
Moreover, a date can be defined (also see 5.2)

dECIose HSave ‘*Category & Workflow BStatus 2| mail @Tools u Search SMaster tﬁunks %Aﬁachment Vi')F'rint

Incident COC-150414154812-w94 Reset SAP R/3 Password
Type Service Request
Root cause Senvice User ] Details Equipment
Category SAE Easic Name: Martha Pfahi =1 @, Display
> S ¢ UserID: " mpfahl 4 Gt Tickets
Brief description Reset SAP R/3 Password Phone (office): " +49 8677 97470 £ Reporter
Attachments: Position / Department. ™ ,/©
Client: COC Germany AG
> s o Cl (root cause) | Details Linked Cls
Request l Work history I Solution Mail history
= Clname: =
2 New entry : A view : : : Type / Category: G
+++ Authorisations only in compliance with the data policy +++ Manufacturer / Model: © J/r i
Sl iy
SAP User: mpfahl DEsciption. 2!
Module: MM
Mandant: DE Work status History Tickets
Priority: standard =i
Phone: +49 8677 9747 0 Status: new
Date: " not required ;=
Responsibility Processorlistl
Responsible personfteam Phone Client Department Deadline Monitor Proc [Min]
[Service Desk] +49(89)123456 COC Germany AG IT-Senvice 2015-04-15 14:48 (2]
Process editor / [Process team]
[SAP Basis Senvices] — COC Germany AG Development — 0o =
Screenshots:
s
4

Fig. 15: Information on ticket processing (work status)

If you are using HelpMatics™ CMS, the additional service selection option is available. If a new
service is selected, a check will be made if the current priority of the ticket corresponds to the service
priority. If not, a dialog window for priority selection opens.

For more detailed information, refer to the HelpMatics™ CMS module documentation.
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4.4.5 Ticket history

The History displays the changes of priority and status recorded in the course of ticket processing.

Work status ] History Tickets
Statuses
new Etzler , Daniel 04.09.2018 10:03
work in progress Bartels , Alexander 05.09.2018 11:52
Pricrities
standard Etzler, Daniel 04.09.2018 10:03

Fig. 16: Ticket history

No changes can be made there.

4.4.6 Documentlinks

Ticket links to other incidents, problems, RFCs and changes are listed in a separate tab. This
makes the process chain more consistent and transparent and interconnections immediately
recognizable.

4.4.7 Ticket responsibility

In the RESPONSIBILITY tab you can see the responsible person/team and the current process editor.

Responsikdity | Processorlist |

Process owner Phione Cliand Dapartment Daadling Monitor Proc  [Min)
Kad , Claudia
Process adiar | [Process leam)

|rpplication Sensog] —_ COC Garmarny AG IT-Sardce - =l

Fig. 17: Responsibility

The PROCESSOR LIST tab shows you the course the ticket has taken at the ServiceDesk. You can see
there who was process editor and when, and who edited this ticket at what time.

Responaibility | Processor kst |

Process edilor ! [Process eam] Fhone Cliant Dapartment Assigned Back  Froc  [Min]
Madl, Clauia aTe COC Garmany AG Drevetopmeent 11102010 1412 - Q =
[Application Sarvce] - COC Garmany AG IT-Gardce 11102010 1492 9

Fig. 18: Processor list

The process editor currently logged in can enter the time he/she needed for processing the ticket in
minutes (click the small button next to PROC. TIME [MIN]). The process time per process editor and day
will be summed up. The process times can be retrieved via the HelpMatics™ Reporting feature.

In the RESPONSIBILITY tab (person currently responsible and process editor) an icon (see table below)
is displayed in the responsible person line next to DEADLINE and the processing time PROC. [MIN].
Depending on the monitoring status (as defined in the SLA) of the ticket, the different monitoring levels
are represented in different colors in order to highlight when the specified deadline has been
exceeded.

The same representation is used for process editor monitoring (Process editor/[Process team]) - if
activated in the process editor documents.
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Monitoring level

Icon

MONITOR IN TIME / Status [on hold]
MONITORING IN TIME

MONITOR LEVEL 1

MONITOR LEVEL 2

MONITOR LEVEL 3

4.4.8 Request

A request is entered into this area.

O
O
O
S

sigciose bdsave kcaegoy  @wordow [ saws  Euai (Broos () searcn  Gymaster ks §yatachment [ Print
Incident COC-150414154812-w94 Reset SAP R/3 Password
Type Service Request
Root cause Senice User I Details Equipment
Catoaory S Basic Name: Martha Pfanl &I Q@ Display
] - P UserD: " mpfahl 4 i Tickets
Brief description Reset SAP R/3 Password Phone (office) F+49 8577 9747 0, gy Reporter
Attachments: Position / Department:© ;17
Client: COC Germany AG
- - — Cl (root cause) | Details Linked Cls
Request | Work h|st0ry| Solution Mail history
Cl name: =
%ﬁ;"‘ﬁ%‘;s 32?:"3\: Klink | Dpeicateson:  Culla
-03- 232 py Fred Klinker PR
Manufacturer / Model: !
SAP-User. Pfahl, Martha Descrotion. o
Client DE CSCHPROIE 4
Maodule: MW
Work status | History Tickets
Priority: standard =i
Status: new
Date: " not required ;=]
Responsibility | Processor list
Responsible personfteam Phone Client Department Deadline Monitor Proc  [Min]
[Service Desk] +49(89)123456 COC Germany AG IT-Senvice 2015-04-15 14:48 (2]
Process editor/ [Process team]
[SAP Basis Services] — COC Germany AG Development — 0 =

Screenshots:

g
e

Fig. 19: Information on request, work history, solution and mail history

4.4.9 Work history

This tab is used for recording the complete action history necessary for finding a solution.

COC AG
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4.4.10 Solution

You can enter the solution description in this area. Use the NEw ENTRY icon in the Solution tab to enter
time and name in the solution window. Thus a click on NEw ENTRY above the solution window, e.g.,
causes an entry such as e.g. 30-03-2005 15:32 by Fred Klinker to be displayed if this is the first entry in
the field. If not, a dividing line will be inserted before the actual entry. If you want to see this entry in
the Knowledge base after it has been resolved, check the box ENTRY IN KNOWLEDGE BASE in the
solution window.

Clicking the View button displays request and solution texts in a separate window. This is useful in
case of extensive descriptions. Process editing, however, is not possible there.

4.4.11 Mail history

The complete mail traffic — if created via the ticket - is displayed there in an embedded view. Mails can
be opened directly from the ticket. You can send replies from an opened e-mail unless the ticket has
the status CLOSED.

4.5 Closing aticket

You can close a ticket by setting the status to CLOSED in the action bar.

A dialog with the question ‘Is the user to be informed about the completion of the ticket by e-mail?’ will
be displayed when saving a closed ticket — if the corresponding setting has been made in the client
document.

4.6 Taking over aticket

If you want to edit a ticket you have not created or which has not been assigned to you, you will be
asked - after opening the document - if you want to take over the ticket. After confirming with YES you
can make your entries and save them. You will now be displayed as process editor in the processor
list.

If you do not want to take over the ticket, you can only edit it if you are the person responsible for the
ticket or have been granted extended rights in HelpMatics™.

4.7 Opening aclosed ticket

You can view closed tickets by double-clicking them in the corresponding view. Editing closed tickets
is not possible. To edit closed tickets, click the Reopen button (available only for authorized persons).

4.8 Copying aticket

If the user’s history shows that he/she has had a similar request before, you can copy this data into a
new ticket.

To do so, select the existing ticket in the Tickets > User view and click the TICKET > INCIDENT — COPY
button.
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4.9 Master tickets

4.9.1 Creating a master ticket

A master ticket is a ticket superior to sub-tickets that have been assigned to it. These sub-tickets have
been recorded for other users for one and the same incident, e.g. in case of a mass failure or a
request concerning many users.

Incident COC-090507085345-AAu (Master Ticket)

Fig. 20: Marking a master ticket

To create a master ticket and simultaneously provide information about this ticket, you first create a
new info (see paragraph 10.2). Enter the info text and activate the MASTER TICKET (YES) option. Select
THE MASTER > MASTER INCIDENT- NEW button now displayed on the action bar. In selecting the
command, the information text will be automatically copied into the brief description. Save and close
the new master ticket before editing and saving the information. The priority of the information will
automatically be set to high when the master ticket is assigned. You may, however, change the
priority, if necessary.

Instead of creating a new master ticket you can also select an already recorded ticket via the MASTER
> CONNECT MASTER INCIDENT button. This ticket will then become a master ticket.

Information assigned to a master ticket is identified on the Info display by an icon and by coloring as
long as the master ticket status has not been set to closed.

10.04.2006 07:00  Info Mail-Server Shutdown um 08:00 PM
1 09.04.2006 19:45  Info Sener 05 Migration
A409.04200619:45  Problem Exchange crash- max database size reached

Fig. 21: Info display with the master info being marked
It is also possible to create a master ticket without having information relating to it. In the ticket, use
the MASTER > CONVERT TO MASTER INCIDENT menu item.

Please note: A master template for quickly recording sub-tickets in the Rapid Recorder will not be
available in this case! And sub-tickets can only be assigned or created via the Master menu in the
master ticket.

4.9.2 Assigning sub-tickets

If a master ticket relating to an incident already exists, further tickets should be assigned to it. For
assigning a ticket, select the corresponding master template in the Rapid Recorder when creating the
ticket (all master tickets the information of which is identified as master on the info display are
available). After clicking Transfer Data, the new ticket will be identified as sub-ticket and the following
data will be transferred from the master ticket:

= Type

= Category

=  brief description

= Request and solution description (the transferred text will be marked).

= The person in charge of the master ticket will be appointed process editor and person

responsible for the sub-ticket.

The status will be set to on hold but, in contrast to the standard ticket, it is not necessary to set a
date).

Alternatively, after double-clicking a master info item, you may also create a new sub-ticket via the
SuB-INCIDENT — NEW button. This command is also available via the button MASTER in each master
ticket.

COC AG HelpMatics™ ServiceDesk Seite 28



Holp-Maki<s

Existing tickets can be assigned later to a master ticket via the
MASTER > CONVERT TO SUB-INCIDENT menu item. This menu item is available in the master ticket as
well as in the master info.

Pcose bdswe camegoy  Fhwertow asmu-. Sman (Proots ) Search “usuu- Wuinks  Qyatachmelt - Print

Incident COC-101005085032-CMa Printer is not working Convert to standard incident
Comvert to master incident

Type User Convert to sub-incident

Root cause i ; Name Anna Auer =4 d, Dsplay

Category ‘,.I’xom‘n.y(m‘cn, . Printer Network Uses 10 AAGR! & Repocter

s orking ?

Brief descrption Prnder is not workang Prone (ofice) 97470

Allachments Posicn / Department
Chient COC Germany AG

C1 root cause) | Details LinkeaCts |
Request | Soision | Work history | Mait history | .
~ Clname =
) QA
New enkey AL Type I Category
0 UT * 1)%0m Claudia Madt Masnacturet  Model
Descrighon
Work status | Mistory | Tickets
Pnomy standard =J
Statss Work In progress
Since 05102010 08 %0
Date not required ;v
Responsizdity | Processor st
Phone Chendt Department Deadline Mondtor Proc  [Man)
7 COC Getmany AG Development 4 1 ®
Process editor / {Process team|
Mad , Clausta 376 COC Germany AG Devetopment — 0o

slmmmu

Fig. 22: Action button in the ticket window with master ticket actions

4.9.3 Handling master tickets

All processing steps can be documented in the master ticket. Editing sub-tickets is not necessary.

When sending an e-mail from the master ticket, all addressees from master and assigned sub-tickets
will be entered in the blind copy field of the e-mail.

Upon closing a master ticket, all assigned sub-tickets will be closed as well and the data mentioned in
paragraph 4.9.2 will be updated in the sub-tickets. This does not apply to Sub-Tickets that have
already been closed manually.

4.9.4 Converting tickets

= Converting standard tickets to sub-tickets

In the standard ticket window, under Master, click the CONVERT TO SUB-INCIDENT button, in order to
convert a standard ticket to a sub-ticket and connect it to an already existing master ticket. If the
master ticket is not displayed in the selection window yet, you can refresh the selection list via [F9].

= Converting standard tickets to master tickets

Back in the standard ticket window, you can convert a normal standard ticket to a master ticket if, e.g.,
it has turned out that a ticket has been created for an incident affecting many users. To do so, select
Master > Convert to Master Incident.

COC AG HelpMatics™ ServiceDesk Seite 29



4.10 Scheduled tickets

Scheduled tickets are service requests that, if required, are created using a ticket template and

become active at a fixed point in time. Scheduled tickets are marked by a gray icon & inthe
overviews.

If you create a ticket using the TICKET > SCHEDULED TICKET — NEW button, only ticket templates with
service request type are available. An activation time is to be scheduled for the newly created ticket.
The ticket will automatically be active as soon as the deadline has been met. Up to this point, it
remains in the SCHEDULED status without the calculation of any processing times and escalation levels.

When the date expires, the ticket will automatically be activated:
- Sending an e-mail notification to users and process editors
- Status OPEN
- Calculation of processing time and escalation levels.
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5 Working with tickets

5.1 Action bar

On the action bar of the ticket window you can perform different actions, which are described in the
following. Please note that changing to the edit mode is possible only for process owners of the ticket,
process editors or administrators.

nﬂ-::mse HEE\! = ‘Eﬂe:ﬂl‘[ ‘;.'Hﬂrlﬂﬂw n Stahrs * Mail _’Tﬂﬂls ” Seardh ﬂuasm tbLll‘lH %ﬁnammm —"PIIF!

Incident COC-101005085032-CMa [Primtar is not working
Trpe User | Detnts | Equipment |
oot cause M Anna Auer = ak, Despisy
Calegory Cheni Hardware Prinber Mebyor Ui ID: Ak r-'f Rosporber
Briad descripton Prirbed ig nol warking Phome [ofMioe) ar4T 0 )
ARachmants Position | Depafment © I
Client GO0 Gasmany AG
1 {rool cause) | Details | Linksd Ci
Request Sububan Work hisfory | Mail hisiory
= 1 N =
L Mew eniry “ Wiew - Type | Calepony
F\-: 10:2010 0850 (GMT + 1) from Clawdia Mad Mshisfacturer [ ladsl
ACKENE S M i Description
Work stalus | History Tickels
Prignify standard =)
Salus WOTK @ prepress
Since 05102010 0B:50
Diate " nok required ; =
RS pons i Bility .Prucu:surllsl
Procass owmigr Phone Chant D partmeent Dieadne Manitad Proc  [llin)
L, Claudia 376 COC Garmany A Devilopment OF. 102010 0851 5]
Pro<ass aditor ¢ [Profass team]
Miadl | Claudia aTe COC Garmiany AG Dirwal Gprisanl o =

Screanshots:

I
Fig. 23: Action bar of the ticket window

5.1.1 Categories
A category or a type can be assigned to the ticket. A category or a type can be ;#Categuw .
assigned to the ticket. '

= Ticket category Type

Via this window you can select main and sub-categories. AR G

Zakegory

= Ticket type

You can assign a ticket type there. The type selected may have an influence on the root causes
displayed for selection. When you select a type, this may cause the root cause field to be emptied if
there is no link between type and root cause. Then you have to newly assign a root cause.

New categories, types and their connection to root causes can be created via Administration only.

= Root cause

Select a root cause from this list. The terms that are available for selection are defined by the
Administration. Depending on the configuration, various root causes may only be available for certain
types.

The entry of a root cause is required for closing a ticket.
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5.1.2 Workflow

Here the process editor or the process team as well as the status of the returned tickets is selected.
= PROCESS EDITOR

To assign a ticket to another process editor, click Process editor and select the desired person from
the dialog window.

* PROCESS TEAM

A process team is selected e.g. when the ticket is passed on to the 2™ level.

Use of the default process team will be offered if the following preconditions are fulfilled:
- adefault process team has been assigned to the category
- the ticket is forwarded for the first time

If the ticket has been forwarded more than once, the default process team will only be offered for
selection if the process owner of the ticket changes the category.

= BACK TO RESPONSIBLE PERSON/TEAM

This action is used to return the ticket to the responsible person/team together with a note on the
processing status that is selected from a dialog box (see Fig 24). The status is identified in the ticket
views by an icon (see paragraph 2.4.2) and displayed in the processor list as a numerical value (see
table below).

Workflow > Back to responsible person/team IE

Returned ticket status OK l

" closed / user informed e [
" closed / user not informed e
" further processing required

" incorrect ticket assignment

Fig 24: Dialog box displayed when returning a ticket to the responsible person/team

Process editor / Process team] Phone Client Depariment Assigned Back  Proc.  [min}
Madl, Claudia - COC Germany AG Development 0902 2007 1356 = 0

User Administration] - COC Germany AG IT-Service 09022007 1356 - 0

Madl , Claudia - COC Germary AG Development 09.02.2007 1356 - 0

Madl, Claudia COC G AG D t 09.02.2007 13.56 1

Fig. 25: Processor list with returned ticket status

Returned ticket status Value in the BACK column of the processor list

closed / user informed 3
closed / user not informed 2
further processing required 1

0

incorrect ticket assignment
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5.1.3 Status | E Status - ﬁhﬂai
Here you can manually assign a status to the ticket. " workin progress

ON HoLD status allows you to stop the process time. In this case you have to gn hald

enter a date. assigned external
The closed status is not available to 2™ level team members. closed

In the following cases the status will be changed automatically:

Action: New status:

A ticket with work in progress status is edited again and saved. WORK IN PROGRESS
Exception: The current process editor is the person responsible for the ticket
and the ticket is not transferred.

A date is entered in the ticket and saved. The user is asked if the status isto  ON HOLD (optional)
be set to ON HOLD.

A check is made in the background as to whether the dates entered in the WORK IN PROGRESS
ticket have been exceeded. If a date has been reached, the status will be

set to work in progress (except for sub-tickets) and the process editor in

charge will be informed via e-mail.

A ticket is assigned to a master as sub-ticket. The status of the sub-ticket ON HOLD
will be on hold.

The status of a master ticket is set to Closed and saved: All sub-tickets CLOSED
assigned to it will also get the Closed status.

5.1.4 Mail

Using this button you can send notifications via e-mail. 2| hail

If several Mail Templates are stored, they will be displayed for selection in a selection
window.

HelpMatics ;gi

Select a mail template from the list.

Name Subject —T—
Customer - acknowledgement Your support request "<ProblemShort=" ID: <ReferenceNumber=

Customer - appointment confir Your support request: <ReferenceNumber= Cancel
Customer - short-info Your support request "<ProblemShort=" mit ID: <ReferenceNumber=

Customer - standard-mail Your support request <ReferenceNumber=

< >

Fig. 26: Dialog box for mail template selection

These mails are displayed in the MAIL HISTORY tab.
Mails saved as draft can be viewed, processed and sent under Tickets (my own).
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5.1.5 Tools

Via this button programs can be started. sl

It is possible to transfer data from the Ticket (e.g. a Ping to a configuration item). L Tools
Whether the IP-address or the configuration item number is used can be specified in the
administration.

5.1.6 Search
In the ticket window, a search can be conducted for both, knowledge base ~ ° | S#areh~ ﬁ"'am’_

entries and problems. o Knowledge
In both cases the data can be transferred into the ticket or be opened for a Problem
more exact search.

Furthermore, the search for problems offers the option of linking to problems.

5.1.7 Links

Various configuration items can be assigned _ 3 Yy
to the ticket via Links. " Links = %Aﬁachment aFnnt
These will be listed in the LINKED CIs tab. Establish relation to Config. items

Remove relation from Config. itemns
*  ESTABLISH RELATION TO INCIDENT/PROBLEM
By selecting this button you can assign
any number of tickets Establish relation to RFC/Change
(incidents, problems, RFCs and changes)
being related to the problem and possibly
having significance for triggering an RFC or making a change to the problem ticket.
Linked tickets are displayed in the tickets tab and can be opened by double click. The link will only
be displayed after refreshing the document (Save or [F9] key).

=  ASSIGN RFC/CHANGE
If the HelpMatics™ Change module is available, links to RFCs and/or changes can be
established. Linked RFCs/Changes are also displayed in the Tickets tab.

= REMOVE function
By clicking this button, a dialog box will be opened displaying the links assigned to the document.
Select the link to be removed and confirm your selection.
The link list will only be refreshed after refreshing the document (save or control key [F9]).

Establish relation to incident/problem

Remowve relation from incident/problem/RFC/change

5.1.8 Appendix

By clicking this button you can attach files to the ticket document. Screenshots can %Aﬁachment
be directly inserted into the Screenshots field at the bottom of the ticket window via
the clipboard.

5.1.9 Print

= Print
By using this button you can print the opened ticket in print view.

5.1.10 Button for extended functions

The process owner or team will be changed by clicking the button on the right in the menu bar, '1..?}

the appropriate authorization provided. Usually, the responsible person is the person who created the
ticket.

Via RESPONSIBLE TEAM the responsibility can be placed on a process team.
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5.1.11 Problem Management

&5 Workflow = ﬂ Status | Z|Mail

Forward to an individual process team .
Process editor

Problem tickets can be forwarded to individually composed
process teams. This team is responsible for the particular Process team

problem ticket only. .
Back to responsible person/team

You enter the name of the individual process team, its members and the mail notification option in a
separate window.

5.2 Dates
Work status I History Tickets
Priority: standard =4
Status: work in progress
Date: "reminder ;=]

[06.09.2018 18] [1500 @] 2 i calendar

Fig. 27: Information on ticket processing in the Work status tab

If you enter a date in the ticket, it is recommended to set the status to ON HOLD. In this way, the time
until the date is reached will not be calculated as process time. If the status is set to on hold, a date
has to be fixed. After the expiration of the date, the process editor will receive a reminder. At the same
time the status will be set to work in progress again. This does, however, not apply to sub-tickets.

Fixed dates can be transferred into one’s own calendar. 5 min. before the date starts a reminder
appears. The calendar contains the most important information concerning the ticket and a link (HCL
Notes) to it.

First of all, fix a date by selecting type and time. Then click @ in calendar.
The appointment can also be copied into the view DATES via the in CALENDAR button.

F - pri
,Z\Pm calendar J‘Pnnt

Date « User ~ Reporter ~ Building ~ Room ~ Brief description
| & = 4 2308.2018 16:52  Nagat Henry HO1 HAM.284 Access |IBM Doming

f

Fig. 28: Section from the Tickets > Dates view
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6 Selecting existing tickets

6.1 Tickets (my own)

‘

In the Navigator you find the TICKETS (MY OWN) section. The ticket information identifying you as
process editor or responsible person is displayed in four different views.

You can change the representation of the view, e.g. sorting according to target date, category or type
via the PROCESS EDITOR VIEW button (or TEAM VIEW, RESPONSIBILITY VIEW BUTTON).

The target date can be colored based on the configuration and monitoring level.

PROCESS EDITOR

I HelpMatics™ V10 =

E&]

21.10.2013 15:47

Change  Upgrade HelpMatics

<
@ Open Pruhlem
£

RFC/Change "‘an rocess editor view
” Createdon  |Target date User Reporter Cl (root cause) Brief description
» Madl . Claudia A
b 2 Modul A}
Resources ¥ Team: [Service Desk]
User O %= 03042012 05042012 14:00 Hood, Robin Printjob wird nicht abgearbeitet
Config. items O %= 25032012 28.03.201211.00 [no user assigned] RULMAN-NT Tastatur ist auf Englisch
Tickets @ = 10032012 130320120945 Klein, Rainer Useradministration: Meuer User
User # = 10032012 130320121322 [no user assigned] KWIRTZ01826 Teilnehmenverfigbarkeit wird nicht dargestelit
Config. items @ = 21022012 23022012 13:00 Prockendorfer, Ralf Teilnehmerverflgbarkeit wird nicht dargestelit
:{;ﬁl:ms @& 14022012 140220121022 [no user assigned] FLYD1448 Useradministration: Neuer User
Client monitoring U %& 07022012 070220120939 Braun, Sascha Frintjob wird nicht abgearbeitet
Editor monitoring O &4 04022012 070220120806 [no user assigned] HM ServiceDesk  Tastatur ist auf Englisch
Process editor @ = 04022012 070220121140 [no user assigned] 4002 Teilnehmerverflgbarkeit wird nicht dargestelit
Team O @& 01022012 020220120810 [no user assigned] HAT Ausfall einer zentralen Komponente
Responsibility o @4 23012012 24.01.201209:.00 [no user assigned] DLP1 Ausfall einer zentralen Komponente
Dates @ = 13012012 19.01.2012 14:00 Reichenthaler, Paula Useradministration: Neuer User
Tickats (my own) O @< 14012012 17.01.201211:40 Kreiner. Olaf TRl T Tl
Team M@= 27122011 201220111157 [no user assigned] RARBUCKLENT  Printjob wird nicht abgsarbsitst
Responsibility O @= 97122011 201220111219 [no user assigned] ATHOS Printjob wird nicht abgearbeitet
Dates @ = 13122011 141220111200 [no user assigned] Coler Moniter - THO Useradministration: Meuer User
E-mail drafts ® = 12122011 14122011 11:00 [ne user assigned] 5002 Useradministration: Neuer User
My tasks @ = 16012011  19.01.2011 11.00 Anthelzner, Martin x1 Auto-Ticket - Powerpoint als selbstausfuhrende Datei?
My search @& 17042012 17.042012 1238 Primus, Alexander Teilnehmerverfiigbarkgit wird nicht dargestellt
Mail-in O @<= 06032012 070320120819 [no user assigned] aaa_Testequipment Printjob wird nicht abge®roeitet
e O @9 05122013 051220131228 Auer, Anna Tastatur ist auf Englisch
P e acmont I ®9 05122013 051220131226 Auer Anna 4001 Tastatur st auf Englisch
Reporting . '
Adminishation O @& 21102013 21.10.201313:39 Aaclone. Rob Tastalur ist auf Englisch
Help 0 @< 21102013 221020131146 Aclooney, George Tastatur ist auf Englisch
— R ———————— e e —

Fig. 29: Tickets (my own) — process editor

This view shows all active tickets for which you are entered as the current process editor. See
paragraph 2.4 for an explanation of the icons.

The views can be minimized separately to enlarge the overall view.

TEAM

All tickets currently assigned to your own process team or to the process editors of this team are
displayed here. So you can keep track of tickets processed by colleagues of your own process

team(s).

RESPONSIBILITY

This view displays all active tickets you or teams you are a member of are responsible for.

DATES

This view shows all active Tickets for which a process date has been entered and for which you are
the current process editor.
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E-MAIL DRAFTS

E-Mails created for tickets can be saved as draft and later be sent. The drafts categorized according to
ticket ID are contained in this view. A draft can be edited and sent unless the related ticket has been
closed.

MY TASKS

In the upper part of the right section of this view all active incident tickets are displayed for which the
logged in user is currently the process editor.

In the lower part, all documents of the knowledge base are displayed for which the logged in user is
entered by name or, as member of a team, as manager or expert within the editorial workflow.

MY SEARCH
Tickets can be searched using different criteria.
All search criteria are linked with an "and" operation.

Search for self-edited documents

Type: I Incident [~ Problem Status: |- all - j|
Number [~ for 10 , last edited documents Period: | 10-05.2010 1s]until |18.12.2010 ss]
Content: | Field content: |Printer [ Search l [ Search help l

Fig. 30: Search window

6.2 All tickets

User tickets

The TICKETS > USER view displays all tickets arranged according to clients and the users the tickets
have been created for. Both, active and closed tickets are displayed.

Incident- New Ticket RFC/Change d\Reopen &Print

an Created on v '\User ID [Reporter |Process editor ‘;CI (rootcause) ~ |TicketID ~ Brief description
¥ Agnelli, Sabrina (agnell-sa)
@ < 505092018 agnell-sa Pfeffer , Anja CAT-180905142447-DEt  [HM_13]Access IBM Domino database
&= 05.09.2018 agnell-sa Etzler , Daniel CAT-180905155128-DEt  Access IBM Domino database
@ = 30062018 agnell-sa Admin , Helpmatics CAT-180630164622-HAd [HM_13]Access IBM Domino database
I &= 26082018 agnell-sa Holzer , Kurt CAT-180826120136-KHo  [HM_13] Defect Printer Hardware
@ = 26.042018 agnell-sa Beere , Johannes CAT-180426102635-JBe  [HM_13]Access IBM Domino database
o @<= 29122017 agnell-sa Maus , Carl CAT-171229135814-MC  [HM_13] Defect Printer Hardware
@ = 07.042013 agnell-sa Admin , Helpmatics CAT-130328123423-HAd Reset SAP R/3 Password

» Allison , Gaby (alliso-ga)
» Arbuckle , Ron (arbuck-ro)
b Backel, Jules (backel-ju)

Fig. 31: Tickets per user

Note:

To copy the data of an already existing request of a user's, select the relevant ticket and then click
the TICKET > INCIDENT - COPY button.
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Buttons on the action bar:

= Select INCIDENT — NEW to create a new ticket. The user and configuration item data will be
transferred from the ticket that has just been selected. With the TICKET > INCIDENT — COPY button,
other ticket data, such as request, solution and category, will be transferred. You will then have
the option of recording further data in the rapid recorder.
Please note: When creating a ticket from the RESOURCES > USER and RESOURCES > CONFIG. ITEMS
view, make sure that the current user and configuration item data is transferred into the ticket.

= A selected ticket can be opened and edited by double-clicking it.
= By means of the PRINT button you can print the complete view or the selected document.

= By clicking the REOPEN button, you can open a ticket again that has already been closed. Its
status will then be WORK IN PROGRESS (appropriate authorization provided).

Here as well, you can use the sorting function described in paragraph 2 by clicking the triangles in the
column titles and quick search.

TICKETS > CONFIG. ITEMS

This view shows all workstations supported by the helpdesk so far, sorted numerically by configuration
item number, as well as data on the workstation.

In this view, the action buttons are the same as those in the TICKETS — USER view.
TICKETS > PROBLEMS

This view shows all open Problem tickets. Creation date, responsible person/team and category will
also be displayed.

TICKETS > STATUS
All active tickets are displayed there according to their current status.
TICKETS > CLIENT MONITORING

Here you can see all open tickets sorted by their escalation level.
In the service level document, three escalation levels may be indicated for each client. Before using
the view, it has to be refreshed via the Refresh button.

In addition, you can hierarchically escalate in 3 levels via the MANUAL ESCALATION button.
TICKETS > EDITOR MONITORING

Here you can see all open tickets for which service level monitoring is active (must be activated for the
current process editor or process team). Before using the view, it has to be refreshed via the REFRESH
button.

As is the case in client monitoring, 3 escalation levels are displayed (to be defined via the service level
document for process editors). Here as well you can escalate manually.

TICKETS > PROCESS EDITOR

This view displays all active, i.e. open Tickets sorted by the process editor in charge. In this view you
only require the OPEN and PRINT buttons.

TICKETS -> TEAM

This view shows the tickets according to the process editor's team membership. If a process editor
cannot be assigned to a team, the process editor will be displayed.

TICKETS > RESPONSIBILITY

This view shows all active tasks, arranged by process owner and/or process team. In this view you
only require the OPEN and PRINT buttons.

TICKETS > DATES

This view shows all active tickets containing a date of response, sorted by the process editor or
process team the ticket was received by and by the date of response.
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TICKETS > CALENDAR

This view shows all active tickets containing a date of response and all scheduled tickets displayed in
a calendar view.

6.3 Tickets relating to resources

Via the ASSIGNED TICKETS button you can view the ticket history of the selected user or configuration
item and open a ticket from the list. This button is available in the RESOURCES > USER, RESOURCES >
CONFIG. ITEM view and in the Rapid Recorder.
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7 Problem management

If frequently recurring Incidents are recognized as a Problem, a Problem ticket can be created by a
Problem manager:

A process editor with the [&R_PROBLEMOWNER] role creates a problem ticket based on one or
several incident tickets by using the TICKET > PROBLEM — NEW or PROBLEM - NEW - FROM TICKETS button.
Alternatively, a problem ticket can be created on the basis of a user or configuration item (PROBLEM -

NEW (EMPTY)).

[g,lncident-New Ticketv RFC /Change . ?Reopen ;Print
a Incident - Copy [ Process editor Cl (root cz

¥ Agnelli, Sa Scheduled ticket - New

|

= Problem New (empty) ‘ Pfeffer, Anja

o= . | Etzler, Daniel

@ Problem New - from tickets ‘ Admin , Helpmatics
@ &= 26082018 agnell-sa Holzer , Kurt

@ = 26.04.2018 agnell-sa Beere , Johannes
I @= 29122017 agnell-sa Maus , Carl

@ = 07.04.2013 agnell-sa Admin , Helpmatics

b Allison , Gaby (alliso-ga)
b Arbuckle , Ron (arbuck-ro)

Fig. 32: Button TICKET

Process editors with the [ _ProblemEditor] role must not create or close problem tickets or change their
priority.

Problems are displayed in a separate Tickets/Problems view.

The ticket types available for problem tickets can be specified in the administration. The ticket ID of
problems always starts with PRO. process editors In the ticket views, problem tickets are identified by
the ™ icon.

In reporting, problem tickets are displayed in separate reports.

HelpMatics™ ServiceDesk allows problem owners to create a new RFC or Change for the
HelpMatics™ Change module. Select the respective ticket(s) or resource(s) and then select the RFC/
CHANGE > RFC — NEW OR CHANGE — NEW action in the action bar of the view. Links to the respective
documents will be inserted into the new RFC or Change document. For more details regarding
Change Management, refer to the HelpMatics™ Change manual.

7.1 CI Multi-links

Cl (root cause) ] Details Linked Cls
4001 Handy Siemens
7002 Printer Epson
DocuMize

Fig. 33: CI multi-links in problem tickets

Problem tickets often do not concern only one configuration item. Connections to several (different)
configuration items can therefore be established, or removed, here via LINKS -> ESTABLISH RELATION /

REMOVE RELATION TO CONFIG. ITEMS.
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8 Mail-In

Apart from using the above mentioned option of sending e-mails to users, you can call the
HelpMatics™ Mail-In function by clicking MAIL-IN in the Navigator. In the corresponding view, the user
requests directed to the helpdesk (via a specified e-mail address) by e-mail or via the portal are
stored.

8.1 Mail-In features

8.1.1 Attach e-mail

By clicking the ATTACH E-MAIL TO TICKET button you can create an incident ticket directly from the e-
mail. In order to assign a mail message from the Mail-In to a ticket, the ticket ID must be entered in the
subject.

The ticket ID will be identified by its structure: Client’s initials - time stamp - process editor’s initials.
Only the first ticket ID will be identified in the subject.

If no ticket ID is included in the subject, a ticket can be selected via a selection window.

8.1.2 Create aticket

Via the INCIDENT-NEW (FROM E-MAIL) button a new ticket can be created out of the e-mail. If the sender
is not found in the resources, you have to select the respective user from the selection window. So, all
user data as well as the information from the e-mail will be transferred into the ticket. However, you
have to enter additional data, e.g. category and, if applicable, configuration item, and click Save before
closing.

You can transfer specifically selected contents or attachments into the ticket. Double-click to open the
e-mail and start creating the ticket clicking the INCIDENT-NEW (FROM E-MAIL) button. At first, a window
will open offering the attachments and the text for selection. If nothing is selected, the complete e-mail
text will be transferred, in all other cases the selected attachments and text. Attachments that are
smaller than 5 kB will not be offered for selection. Confirm the selection by clicking OK to continue
creating the ticket.

The e-mail remains in its original state and is attached in the MAIL HISTORY tab.

HelpMatics X
Selected attachments and selected text are transfered into the ticket.
Attachments: [v pic03796.gif (11 kB) D = 7
ancel
[V pic08542 gif (19 kB) - pic03796.gif

™ Klistjpg (155 kB)
- pic08542.gif

- klistjpg

[Preview using double-click]

E-mail Text " Dear ServiceDesk,

ith my snapshot software, s

Thanks
Bobby
4

Figure 34: Selecting attachments and e-mail text

8.1.3 Reply

Via the REPLY ... button you can directly send an e-mail to the sender without creating a ticket first. If
the e-mail was assigned to a ticket, the reply feature is available unless the ticket has been closed.

e
The & button with its EMPTY RECYCLE BIN sub-menu is available to users with deletion rights and
will remove all e-mails from the recycle bin.
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8.2 Automatic mail processing

With the appropriate configuration, e-mails in Mail-In can be attached automatically to tickets. This
requires that the ticket ID be entered in the subject. If e-mail assignment has been activated for the
client of a ticket, the e-mail will be attached to the ticket, the process editor will be informed and a flag

will be & get.

8.3 Recovery feature for e-mails

If, while creating a ticket on the basis of an e-mail, system incidents, such as a power failure or client
crash, occur, the e-mail will first not be visible in the mail-in and the ticket might not be saved.

Via the ACTIONS -> ADMINISTRATION > RESTORE E-MAIL menu the e-mail can be recovered and put back
to the mail-in, then a ticket can be created again.

If possible, the messages should be recovered soon since e-mails that are older than the month
before will not be offered.
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9 Knowledge Base

Clicking Knowledge Base in the Navigator will open a new window with its own Navigator (on the left)
and Viewer (on the right).

Knowledge Search
| | any word (OR) +| I Soltions [~ Use word variants Search Clear results
- ¥ FAQs [ Fuzzy search

@ Open New entry ";F’rint

~|  [FAQ Client ~ Creator ~
Back ¥ Hardware
YPC
Pl I How do | create a 'send to' short cut for a Zip Drive? coc Bartels . Alexander
Category - Solution ¥ Network
Category - FAQ ¥ Operating System
Topicality ¥ MS Windows XP
Creator I How do | configure Microsoft Windows XP to have the 'classic’ windows look? coc Bartels , Alexander
Client release } SAP R/3
Editing process ¥ Software
Reporting ¥ HelpMatics
Administration # How can | contact COC AG? coc Auer , Anna
Help ¥ Lotus Notes
I How do You report a Bug? all clients  Klinker . Fred
I How to prevent save conflicts in notes documents? all clients  Auer, Anna
¥ MS Excel
¥ I 20.11.2009 09:35 (GMT + 1) von Development: PDF Dokuments kdnnen nicht mehr gedfin CAT Mad! , Claudia
& Why can't | open an Excel workbook that contains XLM macros? coc Bartels . Alexander
I Why, in Microsoft Excel, does my page print at 100-percent ecale when | select the 'Fit To' o COC Bartels , Alexander
¥ MS Word
I How can | prevent two words from breaking at the end of a line in Microsoft Word? coc Bartels , Alexander
& How can | print a list of all my AutoText database entries ? coc Bartels . Alexander

Fig. 35: Navigator (on the left) and Viewer (on the right) in the Knowledge Base

The knowledge base contains documents that have been stored in the knowledge database after the
ticket processing. Moreover, new entries can be created as FAQ or solution directly in the knowledge
base. Optionally, entries can be released after their editorial processing. FAQ’s and solutions can be
linked.

By clicking KNOWLEDGE BASE in the Navigator you open a new window with its own Navigator.

9.1 Knowledge Navigator

The Navigator allows you to select the desired information, which will then be displayed in the Viewer.
Navigation is made by mouse-click.

Under Documents various knowledge document views are available. Depending on whether

Knowledge Search is active (see section 9.7 Search by means of the knowledge search bar) or not,
all knowledge documents or the search result will be displayed in the selected view.
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9.2 Knowledge Viewer

The Viewer is displayed as main window on the right and shows the information selected in the
Navigator.

By clicking the black triangle in the column titles you can change the sorting order. Categorized
columns are hidden. The sorted column is marked by a black triangle * . By clicking the icon again,
you can restore the original state.

Double-clicking a line displays the information contained as a document.
FAQ documents are marked by the @ icon.

Eba Qpen &F‘rint

v| Brief description Released ~ Client ~
* K% @ How to prevent save conflicts in notes documents 08.04.2004 all clients
R K ltimedia nat showing in |E. 14.10.2002 COC
iR @ How da | change my Internet Dialling Number? 14.10.2002 [=ale
IR Heowe can | print a zample of all the Fontz | have on the svstem? 14.10.2002 Coc
R Checking the available space onwour Harddrive. 14.10.2002 GO
®w @ How do | create a 'send to' short cut for a Zip Drive? 14.10.2002 CoC
R Armount of epace LM files can uze on the Server 14.10.2002 CiOc
R kedy cormputer will not recognize any of my COR ports. 14.10.2002 Coc
b2 4 Workflow Eingang: Auftrag wird nicht angezeigt 11.10.2002 all clients
* @wie kann ich den Ansichtsindex fir alle Ansichten einer Datenbank aktualisieren. 19.09.2002 all clients
* | have booted ry PC as normal and | do not have any sound 04.10.2004 coc
*® @ How can | prevent two words from breaking atthe end of a line in Microzoft Waord? 14102002 (8]

Fig. 36: Documents — Creator view sorted by relevance

\[e]{=k
If you sort the first (unlabeled) column, the documents will be sorted by relevance.

The categorization by creator will disappear.

By clicking the triangle that has become black now again in the column header, you restore the
original sorting and categorization.
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9.3 The action bar of the Viewer

Depending on the view selected in the Navigator, you can see different buttons on the action bar.
These are used to carry out certain actions:

Icon Meaning Action

" Print You can choose between:
o = Print - View
=  Print - Document

New entry Depending on the view activated, a new solution or FAQ
- document will be created

& Knowledge search Opens the knowledge search bar

9.4 Iconsin the views

Icon Meaning

e FAQ document

Document relevance. Depending on read count, use count and up-to-dateness,

* the document is provided with O to 3 stars.

9.5 Knowledge document

sigclose  [PlEdt [Print

Solution S0L-100304094502-CMa Amount of space LN files can use on the Server
Type
Ca.legory o Client Application Lotus Motes Ayailability lacal
Brief description Amount of space LN files can use on the Server Client: coc
Aftachments: User group: [ Suppori], [ User]
Problem validity | Origin |
iwmount of space LN files can use on the Server Version:
Configuration:
Language E
Solution Editing status l History] Comment
Yes, the limit on storage space is 50 MB. You will receive a warning message when you reach 40 Status: released
MB. Ifyou receive awarning message, it is very important that you remove any unnecessary files to
clear space before you reach the 50 MB limit. This may seem like a lot of space; however if
unnecessary files are not removed periodically, araphics, web pages, sound files, or other W valid
application files can fill up this space quickly. In addition, there is a set amount of this space that Date until
is required simply to make an account available for use.
Expert

Fig. 37: Knowledge Document: Solution
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sggciose  [JEdt (yPrint

FAQ FAQ-100304110514-CMa How do | configure Microsoft Windows XP to have the ‘classic’ windows look?
Category Operating System MS Windows XP
AR Availability: local
Attachments: Client: coc
User group: [_Support, [ User]
Question Validity
How do | configure Microsoft Windows XP to have the ‘classic’ windows look? VBT WinkP
Configuration:
Language: E
Reply Editing status ] Hlstory] Comment
1. Do a right-click onthe Desktop, and select Properties - Status: e leaad
2. Position yourselfon the Appearance tab. -
W valid
3. Inthe Windows and buttons drop-down box, select Windows Classic Style, as shown below. Date until:
4. Click on OK. Expert:

Configuring Explorer

5. Click on Start\ Seftings \ Accessories.

Screenshots:

Fig. 38: Knowledge document: FAQ

Knowledge documents can be displayed under the Documents navigation item in different views:

View

Description

Category > Solution

Category > FAQ
Topicality

Creator

Client release

Documents offering solutions for user tickets are arranged according to
categories

FAQ documents are classified according to categories

Solution and FAQ documents are displayed according to the year and
month of their release

Solution and FAQ documents are classified according to their creator. If
the document has been transferred from HelpMatics™, the process editor
having closed the incident is the creator of the document (only solution
documents are transferred from HelpMatics™). For documents that were
created directly in the knowledge base, it is the user who created the
document. In both cases, the documents may have been processed by
experts (see History tab in the document).

Classification of solution and FAQ documents according to their client
membership

9.6 Notes integrated search

HCL Notes provides various options of searching for documents. For further information on Notes
standard functions, refer to the HCL Notes help.
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9.7 Search by means of the knowledge search bar

Knowledge Search
| |any word (OR) j ™ Soluions [ Usewordvariants
¥ FAQs [~ Fuzzy search

Search Clear results

Fig 39: Knowledge search bar

The knowledge search bar (see fig. Fig 39) offers an easy way of searching, with categorizations of
the search results being maintained. You can view the search results in different
sortings/categorizations by selecting the corresponding view in the Navigator. Storage of the
knowledge database on an HCL Domino Server and full text indexing of the database are a
precondition for an optimal functioning.

SOLUTIONS AND/OR FAQS

Decide whether the search results are to come from the solutions and/or from the FAQs area. If you
change to the Category - FAQ or Category — Solution view, you automatically switch to FAQ or
solution, and the search result will be restricted accordingly.

FAQ documents are identified by @ .

ALL WORDS (AND)

Enter the individual words by separating them with blanks. Notes will search for documents containing
all words specified.

ANY WORD (OR)

Enter the individual words into the search field by separating them with blanks. Notes will search for
documents containing one of the words specified.

9.8 Editing process
Users with manager or expert roles have access to the editorial section of the knowledge base. Here

entries (tickets from HelpMatics™ ServiceDesk or new solutions created in the knowledge base and
FAQSs) are prepared and released for certain user groups (roles).

Depending on the role, the following views are available in the editing area:

View Description

Editing status Here you find all non-released entries (solutions and FAQs), categorized
as follows:
" NEW

Includes marked requests from ServiceDesk (after preparation by an
agent) and new solution and FAQ documents.

=  ASSIGNED - EXPERT

These documents have been assigned to an expert or an expert
group for editing. This can be done by a manager or by an agent on
the basis of the categories entered.

= CHECKED - OK

Here documents checked by experts and waiting for release by the
manager are collected

=  CHECKED - DENIED

Here all entries are collected that were denied or rejected by the
expert. The manager can delete them or assign them to another
expert.

Expert (my own) Here, an expert will find the documents assigned to him/her for editing.
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Manager (my own) Here the knowledge manager will find all documents that have been
newly created or returned by the expert as well as documents the validity
of which has expired.

There are three types of editorial workflow:
COMPLETE EDITORIAL WORKFLOW

Each document is assigned to an expert by the manager or, automatically, based on its category. The
expert revises and processes the document, adds information and returns it to the manager as Denied

or OK. The manager particularly checks the setting of the client as well as (in the Enterprise setup
only) of the availability and releases the document for certain user groups or — in case of denied
entries — deletes the document or assigns it to another expert (see appendices 15.1.1 and 15.1.2).

MINIMUM EDITORIAL WORKFLOW

The manager releases documents directly — without experts being involved. The following settings
should not be activated under Administration - Modules: “Import expert data” and “Automatic
assignment of experts” (see appendix 15.1.3).

BYPASSING THE EDITORIAL WORKFLOW

Documents are released for all user groups without editorial processing. This requires the setting
"Avoid editorial workflow" under Administration — Modules. If this option has been activated, a further
option is available: “...but consider restriction to client.” If this setting has been activated, the multi-
client capability is maintained (see appendix 15.1.4).

9.9 Knowledge manager — tasks

The manager is responsible for the editorial processing of knowledge documents | ‘;Assign T Eﬁ £

and for deleting irrelevant documents from the database. Expert ... |
The following buttons are available on the action bar of the solution and FAQ - Experts group ...
document:

Action Description

Assign > Expert ...

Assign > Experts group

Assign >
Back to expert

The manager can specify which expert shall edit a document. By selecting an
expert from the list, the manager forwards the document to this expert.

Instead of assigning a document directly to an expert, the manager may also
define an experts group. Every member of the group can then take over the
document for editing.

If a document has been returned by the expert to the manager as Checked — OK
or Checked — Denied, the manager can return the document to the same expert
again if the editing process has not been performed to the manager’s satisfaction.
The manager is then requested to make a comment, which is to be entered in the
Comment tab of the editing status.

Release The manager releases the document — usually after it has been edited by an
expert — for certain user groups. Before that, the following field contents in the
release tab are to be checked in particular:
= Availability (Enterprise setup only): Is the document to be released only in the

current instance of the knowledge base or is it to be edited in the global
knowledge base?
= Client: The document may be restricted to a client or may be valid for all
clients (selection: _all).
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9.10 The expert’s tasks

The expert is responsible for supplementing and editing knowledge documents. He/she makes sure
that the information in a document is complete, clear and correct.

The action bar of the solution and FAQ document has the following entries:

Action Description

Forward to Manager — With this function the expert confirms that the document is ready for

Checked > OK release and returns it to the manager.

Forward to Manager — The expert returns the document to the manager without having

Checked - denied edited it if e.g. the subject is not his responsibility. The expert is then
requested to make a comment, which is entered in the Comment tab
of the editing status.

9.11 Availability of knowledge documents

ENTERPRISE:

Via the Enterprise setup, knowledge documents that are characterized as global in the availability field
will be distributed to all knowledge base instances company-wide.

If, in a local instance, the availability of a knowledge document is set to global, it will be removed from
this instance and integrated into the editorial workflow of the global knowledge base instance: The
knowledge manager of the global knowledge base instance can decide on the further procedure of the
document.

A document that has been provided with “global” availability in the global knowledge base instance
and that has been released will be distributed to all knowledge base instances company-wide.
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10 Info management

10.1 Functionality

The Info Management can be used for various purposes. The display of current messages via the info board
is only one possible field of application.

Further applications:

= Providing current messages via the info board or via the HelpMatics™ portal (e.g. important information
for all support team members, or on failures, changes); pre-scheduling of messages. Select under
Medium where the info is to be displayed.

= Documentation of incidents

= Basic change management

= Storage and exchange of documents, processes or other information to be distributed in support
= Connection to the Intranet for messages to the users

= Connection to master tickets (see 4.9)

10.2 InfoDisplay

—_2407.2008 1449 Problem _Exchange Server down

By incicent-New & Ticket RFC/Change  ~{VReopen (-yPrint
[ServiceDesk |
- Createdon ~ UserlD  |Reporter Process edifor |C1 (root cause) ~  TicketID Brief description
s ¥ Berg , Jacob (bergja) ~
e  Bingo, Peter (bingo-pe)
Config. items ° 404092018 bingo-pe [SAP Basis Senices COC-180904100646-DEt Reset SAP R/3 Password
Tickets M U 05092018  bingo-pe Bartels , Alexander PRO-180005115057-BA  Siow Network
User ) > 1104,092018  bingo-pe Etzler, Daniel COC-180904100225-DEt Siow Network
Config. lems B @ 05042018 bingo-pe Auer, Anna COC-180405150845-A8 [HN_13] Wrong proxy server settings
Problems U 0= 31032018 bingo-pe Holzer, Kurt COC-180331132656-KHo [HN_13] Lost Smartphone
Status © % 20082018 bingo-pe Plahl . Martha 4001 COC-180820100450-MPY [HI_13] Reset SAP R/3 Password
Client monitoring @< 20052018 bingo-pe Maus , Carl 4001 COC-180520080058-MC [HM_13]Access IBM Domino database
Editor monitoring O 24022018  bingo-pe Mustermann , Max COC-180224082052-MMu [HM_13] Reset SAP S4 Password
Process editor © < 22022018  bingo-pe Plefler . Anja 4001 COC-180222114931-APf [HI_13] User Administration
Team U ©< 18022018 bingo-pe Beere , Johannes COC-180218124813-JBe [HN_13] Server need a new important update
Responsinility ° 13012018  bingo-pe Pfahl, Martha 4001 COC-180113124428-Pf [HN_13] Reset SAP R/3 Password
Datee » Biass , Gunter (blass-gu)
Calerxder » Blinker, Hans (birker-ha)
ilecknte (tny.owa) » Boston, Albert (boston-al)
i » Brandell, Kevin (brande ke)
[~ Burm_ Cospar (bura-ca)
Dates el L 04092018 burg-ca Etzler, Danlel COC-180904100404-DEt Slow Network
E-mail drafts W 0= 07012018 burgca Holzer, Kurt COC-180107422758-KHo [HM_13] Wrong prowy server settings
My taske B 0% 05082018 burg-ca Beere Johannes COC-180805104053-JBe [HH_13] Windows 10: access violation by ComSec.exe
S U 0= 30072018 burgca Plahi, Martha C€OC-180730090735-MPf [HM_13] Lost Smartphone
MaiHn B 0= 20062018 burg-ca Etgler, Daniel COC-180620105057-DEt [HM_13] Windows 10: access violation by ComSec.exe
Knowledge @ o= 29032018 burg-ca Admin , Helpmatics COC-180329165017-HAd [HM_13] Windows 8: access violation by ComSec.exe
Info management ©= 07012018 burg-ca Pleffer, Anja COC-180107145944-APf [HM_13] Reset SAP S4 Password
Reporting S 10042015 burgca Urlaub, Farin COC-150331143714-Fur  Battery 0.0.0
Administration » Carl, August (carl-au)
Help ¥ Currie, Luce (currie-lu)
» Dinkel , Susanne (dinkel-su)
» Dow, Lula (dow-lu)
» Dunkert, Paul (dunker-pa)
» Eiseisberger , Hoiger (eiselsb-ho)
» Eugenstein, Sandra (eugens-sa)
» Gable , Darcie (gable-ga)
» Gant, Lisa (ganti)
» Gelb, Friedheim (gelb-fr)
» Glidden , Alnsley (glidden-ai)
» Grau, Betty (grau-be)
» Grosberg , Rudy (grosbe-ru)

Fig. 40: Position of the info display
Via the info board information is displayed quickly and timely. The VALID FROM DATE, the type and the info-text
are displayed.

After clicking Info Management in the navigator, the associated window opens, and, by clicking the INFO -
NEw button, you can create new info.

To show information in the info board it is necessary to activate the SHOW IN INFO DISPLAY option. The entries
will be sorted by Priority and start of validity (Valid from / in descending order).

Additionally, info can be released for the portal (SHOW IN PORTAL).

HelpMatics™ divides the stored information and documentation into three categories: Problem, Info and
Change. Other categories can be created, if necessary.

You open an entry selected in the view with EDIT or by double-clicking it in order to change it.

| I
ENTERPRISE:

Info documents can be provided with Local or Global availability. It is not possible to downgrade the
availability from Global to Local.
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11 HelpMatics™ for mobile devices

The new version not only provides a completely revised HelpMatics™ web client .
but also an optimized interface for mobile devices.

The main focus has been on editing Incidents and Problems.

Moreover, you have access to the current messages of the HelpMatics™ Info
Board . linfo board

>
My tickets >
>
>

IMy tickets - Building

The mobile interface is not limited to special devices but allows mobile access to il tickets
HelpMatics™ ServiceDesk for all browser enabled devices.

11.1 Initial screen - overview

The initial screen shows the following menu items:
- Info board
- My tickets
- My tickets - building F
- All tickets -

11.2 Info board

The Info board corresponds to the info display of the HelpMatics™ ServiceDesk database in the Notes client.
It shows all current information, incidents or master tickets.

11.3 My tickets

This overviews shows all tickets for which the currently logged in person is process editor or member of a
process team. The tickets are categorized by process editor or process team. The following ticket information
is shown:

- brief description

- represented by icons: Deadline, master/sub-ticket, status, priority, forwarding
- date of creation

- name of the user assigned

11.4 My tickets - building

This overview contains the same data as My TICKETS, however with a different categorization. Here the
tickets are categorized by building (corresponds to user data in the ticket, reg. details - building).

11.5 All tickets

This overview contains all tickets sorted by creation date. This overview also allows you to conduct a search.
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HelpMatics™ for mobile devices ' =

11.6 Ticket processing

Having selected a ticket you will get an overview of selected ticket data. Click on EDIT to shift to the edit
mode. This function will be available if you have the appropriate rights.

The following data can be edited:
- brief description

- Request, solution and editing
Scroll through these three data fields by clicking the prefixed +. To add information, click New entry.

- Process editor
Click WorkFLOW and then PROCESS EDITOR OR TEAM to forward the ticket.

The following data will be displayed for information and cannot be edited:
- Classification: Status, priority, type, root cause and category

- User: Name, phone, location
ClI (root cause): Name, category, network/IP address

- Responsibility: Responsible person/team incl. phone No., process editor incl. phone No.

Having edited the ticket, save the changes you made via the SAVE button.
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HelpMatics™ Widgets

12 HelpMatics™ Widgets

12.1 HelpMatics™ One-Click Ticket

Only one mouse click is necessary for the creation of a ticket when you use the HELPMATICS™ ONE-CLICK

TICKET widget.

The creation of tickets is based on using master tickets. After the appropriate documents (user, config items
to user) and the master ticket itself have been selected, a sub-ticket will be created based on this selection.

12.1.1 Installation

Refer to the HelpMatics™ Admin documentation for the installation requirements and installation notes.

12.1.2 Structure of the widget

@HH ServiceDesk ¥6.5 - IBM Lotus Notes
Fie Ect Wew Creste Actions Tool Window Help

A Home x

N-S0ve=BHESD

=&l

= 28.09.2010 16:08 Inifio Updates ane acailable F one-Click-Ticket b |
T8 e
— Master inddent | Creation dat
@ Open glmlum- New roblem “Asshnuﬂclw!s ;jUwr- Mew i Cong. item E RFC f Change : to Lotus Notes  27.09.2010
E : - = Frinter retwork falore  01.10.2000
[Sonscobesk Mame |U:a|'ID '\ |P‘hnna {offica) ~ Room = |Buidln\] = |Danaﬂmant = |Cllurl ~
o ¥ Agrelli, Sabrina aq_nell-sa +47(044) 8092734 IUE023 AE1 Fh.d\..uclian COCSM!:.eHam
s Allison . Gaby allise-ga +43(07) 5676621 VIE1D4 i Training COC Austria AG
Config. itemi Arbuckle , Ron arbuck-ro 40 (089) 6645324 MUC 24 E21 Excmcutive COC Ganmary &
Tickets Auer, Anna Aduer offphone1224 COC Gamany A
Wser Auer, Anna auer-an +49 (08677) 977795 BGHA 21 M350 T COG Germany &
Canfig. itemns Backel, Jules backelu +47{044) 44444 ZUE DS AE1 Executive COC Switzerdan:
Problems b Barbeiss . Barbel baerbe-ba +40 (08%) 6645101 MUC103 E24 Training COC Germany &
Status Bartal: , Alexandar ABanels +40 8877 3747 455 Devaloprmant  COC Gamarny A
Client monitoring Baels Alexander hadels=al =49 (18677 A747SEBGHYYd  MSO  Development COCGemanyA |
Editor monitoring Berg. Jacab berg-ia +40 (089) 6601234 MUC 012 E2 Cantralling COC Germany A
Process editor Bingo, Peter binga-pe 40 (050) GB45148 MUC102 E2 Project T Pride
Process owner Blazs , Ginter blazs=gu +49 (099) 66451011 MUC.254 E24 Training COGC Gammany &
Dates Blinker . Hans birker-ha +49 (099) 6645323 MUC42 EN Cantrolling COC Germany A
Tickets (my own) ¥ Boston. Albert boston-al +43(01) 5676821 VIE.042 01 Execulive COC Austria Al
Pracess editor Brandell, Kevin brande-ke +43(01) BE7EA2T  VIE 023 co1 Marketing COC Austria AG
;’;::‘* T Brauer, Lizelotte brauerli +49 (030) 66451042 BER100 A1 Training COG Gemany 43 | 4] | |
My tasks Bublak . Andreas bublak-an +49 () BEF7-9747-1 COC Gemany A
Ty hotte . tina COC Germany A
Mailin Huber, Alfred AHuber +49 (0)8677 9747 3 Devalopment  COC Garmary 4 || L2 Day-Al-A-Glance =
Knowledge Madl, Claudia madl-c 376 Development  COC Germany A 4 Do 14.10.2010 [
Info management Miebawer. Daniel nicbaue-da COC Germany A
Reporting Pauluhn, Danijela paulubn-ds +49 {0) 8677-9747-1 COC Gemnany A B N e
Administration Reschka, Peter reschka-pe COC Germany & [Today] 14.10.2010
Help ezt anton 7890 COC G A
‘Waltl . Martin walthrna +49 () BE7 70747 Applications & 5 COC Germany A 4  Dktober 2000 |
¥ [Docullize] MUC 342 EX Confrolling  COC Germarny A MDMDFSS
[Kalliste] ZUE. 08D #AE1 Executive COC Switzeran: 1 23
45 6 78 910
1112 131415 16 17
@19 202 2 DM
25 2% 27 28 29 W 3
c
© 2010 by COG AG ‘ :
KIN| JLI|ES s

Fig. 41: HelpMatics one-click ticket widget
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The widget is shown on the right sidebar as soon as one of the
HelpMatics™ views has been opened.

All master tickets are shown in chronological order. The entries

backed in light red are master tickets for which information is
available.

The menu bar offers two actions:

- Refresh of the master ticket display
- Opening of the master ticket currently selected

12.1.3 Creation of sub-tickets

The following actions are required for the creation of sub-tickets:

Holp-Mak<s

B One-Click- Ticket
@ el @

| Master incidet | Crestion dat
CQuesstion bo Lotus Notes  27.09,2000
Prinker risbwork Fadure 01.10.2000

- Change to the resources/user view. Select the user a ticket shall be created for.

. Itis also possible to select a config. item assigned to a user.

- On the one-click-ticket widget on the right sidebar: Double-click the respective master entry.

A Stanseie DEDesign - Design Wechse! T WM ServiceDesk x| Siarisefte ‘Widget Cataiog - By Category
D y@isa (TR 50 ¢ =%=0ho
S 2672013 1000 __info___Waw AN veraon coming n Gioter
= ﬂ o1 i v
N B ovan [Epent-new [EgyProbiem  (jAssinoatots Guser-ew BEuuomen:  [E]RAG/Crange  gprm
B 3 Marme. UseriD [Phone (cfice) ~  |Room Buiding Department ~ |Cliert - |man
o ¥ Bartels Slexander badeissl  +dQ(DESTT)STTSEBGH I MSD
- ¥ Biacs . Gurter biassou ~49(089) 6345101 TMUG 254 E24
@ ¥ Blinker . Hans bikerha  -49(089)6515323 MUC342 1
L Eoston , Alpert beston-al +43(01) 5678921 VIE.042 co1
" Brandell Kenn bandcke  +43(01)5678921 VIE 023 o1 GG Ausirin AG X B
o 40 (030) 60451042 BER 100 ADY COC Bormany A X
CBERm AL
49 (08677 S74TZEBGH 231 M50 COG Germany A X
u +49(030) 6545232 BER231  AD2 O Garmany &
- ~40(030) 6345080 BERTOT  ADY €02 Germany A
+40(DBTT) S7471ZBGHI0S M5O COC Germany 4 X
o ~49(030) 4568558¢ BER 200 a0z COC Germany A X
e 41(044)8002734 ZUEDES  AET GOG Swizeriam X
¥ Eiclcberger, Holger  emelsiha  +40(0577)97475480H 103 M5O erl  COCGermanyAX
L] ¥ Eugenstein . Sandm sugorasa  +49(0511) 845105 HAN 101 HO1 GOG Germany A X
& Gs gablega  +49(0511)BSASZAHANIDZ  HO1 Germany A
ganti ~43(01) 5678621 VIE102 o COC Austria A3 X
c gctbr +49(089) 65451014 BOH 234 M) GOG Germony A X
Giddan . Ainsley oliddonal  ~40(0511) OSBZ3EHANZES  HOI €O Gormany A
» Grau Baty araubs 40 (03677} OTATACBOHASE WSO COC Germany A X
¥ Grey. Marc grema 6606 AexFacoy X
Grosberg . Rudy grosberu  +49(030)6545M2 BGH205 M5O Production  GOG Garmany &
Gusvon . Peter ussenpe  ~43(015678021 VIEO! o Conkrollng  COC Austia A3 X
Has. Fionry hartro +43(01)5678821 VIE 023 o Producton  COC Ausirin A X
Havtachek  John havacio  ~49(0I0)6S47E9 BERZI  AD2 Production  COC Germany &
Hazen. Bob hazenbo  +40(0511)6SIS23AHANIS  HOI Production  GOG Germany A
Hel, Rober [ 43(07) 5678821 VIE 102 o Production  COC Ausia A3 X

Fig. 42: Creation of a ticket concerning a selected user

38 eipitatca™ OneClick
o e

Maser Incient reilgstam
Faite of 5 i comp... 14122012

Ticket- D
COC-12121498104..

The data of the selected user will now be used for creating a sub-ticket for the master clicked on. The link to
the newly created sub-ticket, the time of creation and, if required, a note concerning an e-mail address that

has not been stored will be displayed on the status bar.
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12.2 HelpMatics™ FastText

HelpMatics™ FastText is a widget that provides configurable text modules in the HCL Notes sidebar. Ticket
processing by using text modules will reduce process time and improve ticket quality.

elpMatics™ FastText -=
- = Hieh=0
! @Dpsn uAss\gnedlmksls f Print W
Name UserID ~ Phone (office} ~  |Room ~ Building ~ Department ~ |(Client ~ man. ~ @ Kind regards
P ¥ Aqnelli Sabring aanell-sa +41 (044 8092734 ZUE 02 AE1 Production  COC

i Allison , Gaby alliso-ga +43(01) 5678921 VIE. 104 co1 Training COC Austria AG X
Config. items Arbuckle , Ren arbuck-ro +49 (089) 6645324 MUC.24 E21 Executive COC Germany A
Tickets Auer. Anna Auer offphone1234 m COC Germany A

T Auer . Anna auer-an +49 (08677) 97779S BGH.121 M50 I COC Germany AX

Config. items Backel . Jules backelju +41(044) 44444 ZUE0B9 AE1 Execulive COC Switzerlan X

Problems b Barbeiss . Barbel baerbe-ba +49 (089) 6645101 MUC.103 E24 Training COC Germany AX
Status Bartels, Alexandsr ABartels +49 B677 9747 455 Development  COC Germany A
Client monitoring Bartels, Alexandsr bartels-al +49 (08677) 97475 BGH. 114 M50 Development  COC Germany A
Editor monitoring Berg . Jacob berg-ja +49 (089) 6601234 MUC.012 E21 Controlling ~ COC Germany A

Process editor Bingo , Peter bingo-pe +49 (089) 6645149 MUC.102 E21 Project IT Pride X

Process owner Blass , Gunter blass-gu +49 (089) 66451011 MUC.254 E24 Training COC Germany AX
Dates Blinker , Hans birker-ha +49 (089) 6645323 MUC.342 E21 Controlling ~ COC Germany A

Tickets (my own) ¥ Boston , Albert boston-al +43(01) 5678921 VIE.D42 co1 Exscutive COC Austria AG X

Process editor Brandell , Kevin brande-ke +43 (01) 5678921 VIE.D23 co1 Marketing COC Austria AG X

Bcess mumes Brauer , Lisslotte brauer-li +49 (030) 66451042 BER.100 A1 Training COC Germany A X
E;':;m Bublak, Andreas bublak-an +49 (0) B677-9747-" COC Germany A

A hotte . tina 9999 COC Germany AX
Maitin Huber , Alfred AHuber +49 (0)8677 9747 31 Development  COC Germany A
e Madl . Claudia madl-c! 376 Development  COC Germany A
| < Reschka, Peter reschka-pe COC Germany A

Help test, anton 7880 COC Germany AX

¥ [DocuNize] MUC 342 E21 Controlling ~ COC Germany A X

[Kallisto] ZUED89 AE1 Execulive COC Switzerlan X

Fig. 43: HelpMatics™ ServiceDesk with FastText widget in the sidebar

For system requirements and configuration, refer to the HelpMatics™ Administrator manual.

You drag a text module into a text field via drag & drop. The modules may be used e.g. in the process or
solution field of the ticket or in the description or edit fields of RFC, change or task.

o T ) D ) Sametime Contacts
sgcioss fsave skcateqoy  (Bwordow B stetus | fuan (MTools () searcn  FhyMaster  Wiinks G atachment [y Print O
N ) HelpMatics™ FastText
Incident COC-111025105316-AAu Intrusion alert auf Firewall
Blee=20
Type Incident 3 - Losung 2nd-Level 0 all Modules
U Detail: E it
Root cause Information SEr 1 sals G D=L I @ Kind regards
Category Security & Security Violation Name: Bernhard Aicher =l @, Display
:dm\m.slralmn UserID: " ziche-be &l Reporter
Brief description Intrusion alert auf Firewall Phone (ofiica): "1234J
Attachments: Position / Department ” dev 1 " Development
Client COC Germany AG
Cl (font.s2sse] | Details Linked Cls
Request } Solution ‘Work history | Mail history
Cl name: Alle Senvices =1 @, Display
& "] ™ Copy to Kr ledge B
[ newentry % view opy o fnowiecge Base cip: AAUR-2JCAET Bremove
03.11.2011 12:46 (GMT +1) from Claudia Madl: Type I Category: LV
F
Problem solved Process owner -
[<ind regards Work status | History Tickets
Cl
Priority. sehr hoch =i Specified priority !
Status: work in progress
Since: 25102011 10:53
Date: " not required =

Fig. 44: Dragging modules into the ticket via drag & drop
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You differentiate between public and private text modules.

iir HelpMatics FastText - New X

- Public text modules are defined centrally by an L I |

authorized person. These text modules are Category * v|

available to every process editor. When a text

module is created or edited, Public is selected. Text
- Additionally, every process editor can create Type  [Public

personal (private) text modules. These are only

visible to the respective process editor. It is not

possible to define a special type for a private text

module.

Cancel

The entries can be managed and updated via the menu or
context menu. The individual text modules will be
categorized according to the respective HelpMatics™ modules (ServiceDesk, Change, ...).
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12.3 HelpMatics™ Mail-In Monitor

The Mail-In Monitor visualizes the HelpMatics™ Mail-In area and
informs the user about incoming e-mails. This widget will be
available after the installation whether the HelpMatics ™
ServiceDesk database is open or not.

For system requirements and configuration, refer to the
HelpMatics™ Administrator manual.

The Mail-In Monitor is located on the HCL Notes sidebar and,
depending on its width, displays information on sender, recipient,
date and subject.

The following functions are available:
- Refresh o
- Open mail o

o]

- Monitoring on/off '
- Help &

Depending on the configuration, a popup may inform the user about incoming e-mails.

v

i) HelpMatics

Holp-Mak<s

@ HelpMatics™ Mail-In Monitor ~=

= (B e

Created Sender

11/311 12:52...  claudia madl
11/3/1112:51... claudia madl
9/21/10 5:06 ... Development/COC...,
9/21/10 5:06 ... Development/COC...
9/21/10 5:06 ... Development/COC...
9/21/10 5:06 ... Development/COC..,

S

There are new mails in the HelpMatics Mail-In.

h

Fig. 45: Info popup on incoming e-mail
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13 User tips

13.1 Retain view column sorting

Holp-Mak<s

If column sorting is to be retained in the views, the retain view column sorting option can be activated in the
user preferences (see Fig 46).

To do so, in the FILE > PREFERENCES menu, open the USER PREFERENCES and activate under BASICS NOTES
CLIENT CONFIGURATION > ADDITIONAL OPTIONS the option RETAIN VIEW COLUMN SORTING.

i Preferences O X
]m Basic Notes Client Configuration v F o
Accvounts = ) Startup and shut down
Hcotes e ienF ool Empty trash on application close Local application folder:
Calendar and To Do {if not emptied at a timed interval): :
: GG v [CIBM\Notes\Data
Composite Application Editc Al
ways Ask v A7
Contacts Check subscriptions
EorteandCalsi [JAutoSave every [15 = minutes [ otan orimmead
HelpMatics FastText [[] Enable scheduled local agents
HelpMatics Mail-In Monitor
IrTstaII/Update Display
Live Text —_—
Locations Default Fonts...
Log Settings
Mail Additional options
Notes Ports |+~ Disable View updates as a background task A
Regional Settings N N Retain View column sorting
Replication and Sync **"" ****Enable MS Office 97 SendTo to Notes
Search Use Web palette
Spell Check v Show extended accelerators
Toolbar v Enable MIME save waming
Launch the CORBA (DIIOP) server on Preview in web browser
Web Browser 2
) Standard dialog boxes
Wfdgets Strict Date/Time Input
Windows and Themes Show indine MIME images as attachments
XPages Performance Disable embedded browser for MIME mail
When text language is unspecified use the form's
v Invoke Notes on vCard files v
[[] Automatically lock my Notes ID after |15 _,: minutes
[ Client Reconfiguration Wizard.,.ﬂl
NOTE: Your administrator has disabled some preferences.
< >

Fig 46: File > Preferences > User preferences

By doing so, the column sorting which you made by clicking the > character in the column title are retained
until you click the column title again or activate another column sorting, even upon leaving the program.

The sorted column can be identified by the

F

icon in the column title.

IEEdit %Incident-l‘dew F'rohlem @Existingtickets & Juser-Mew L canfig

~"..v

itern RFC/Change |3 Print

Fig. 47: Resources > User sorted by phone (office) view

COC AG

HelpMatics™

Mame |UserID o~ |F'h0ne (offi .) - ': Foom «~ |Bui|ding -~ |Department o~ |Client o~ |man. o~

b Jackel, Eva jackel-ev +‘49‘(‘ljé6??) Ei?ll‘fBE BGH.202 hAS0 Cantrolling COC Germany &

b Zieglgaensberger, Hans  ziegelha +449 (08677 97478EBGH. 786 k450 tanagement COC Gerrmany & X

b Otto, Karsten otto-ka +49 (08677 974847 BGH. 322 k450 Project COC Germany &

¥ suer, fnna auer-an +48 (08677 97779 BGH.1 21 k450 IT COC Germany &
toger, Janet moser-ja +49 (089) 6545307 MUC 202 E21 Management COC Gerrmany &
Srythe . John smythe-jo +49 (089) 6545308 MUCE21 Ez20 hdarketing COC Germany &
LaRouche , Paul larouc-la +49 (089) 6545319 MUCT21 EZ20 Executive COC Germany &
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13.2 Deactivate categorization by clients

kil

wr
e
-

Many views such as TICKETS > USER (see Fig 48 and Fig 49) start with categorization by clients. Often, this
information is not required in the particular view. If you made the settings according to tip 1, you may activate

Py

and deactivate them. Click the first

icon in the title line to show or hide the categorization. The icon

changes into a black triangle (*) and you get to the next categorization column (in the TICKETS > USER

example the column showing the user names).

@Open Ig.lncident-r«lew :_";'—?_-"_ilnci

. e created on ~ |Llze

* COC Germany AG
k Auer, Anna
k Babcoc , Barbara
k Bartels , Alexander
¥ Bingo , Peter
k Blass, Giinter
k Blinker , Hans
k Brauer , Liselotte
¥ Carl, August
¥ Churchill , Conrad
k Decker , Sahine
b Dow , Lula

Fig 48: Tickets > User (standard sorting) view

@Open Ig.lncident-mew :_";'—?_-"_ilncid

LW created on ~ |User

F Auer , Anna

b Bahcoc , Barbara

k Bartels , Alexander
k Bingo , Peter

b Blass, Giinter

k Blinker , Hans

b Brauer , Liselotte

k Carl, August

¥ Churchill, Conrad
b Decker , Sabine

¥ Dow , Lula

b Eiselsherger , Holger

Fig 49: Tickets > User view (sorted by user
name; client hidden)

Advantages:

* The speed of displaying the view will be increased.

= The Notes quick search can be performed via the column that has been sorted (the user names

column in the TICKETS > USER example)
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14 Glossary

Navigator

Action bar
Viewer
Resources

Rapid Recorder
Ticket
Knowledge Base

Knowledge Document
FAQ
Solution

Roles
SLA

COC AG

left sub-pane of the HelpMatics™ interface, where the primary navigation takes
place

bar in the HelpMatics™ interface, where different action buttons are displayed
right sub-pane of the HelpMatics™ interface, where information is displayed

data sets the ticket creation is based upon, e.g. all configuration items and the
users

for recording all data necessary for further processing a ticket
independent task / request by a user recorded by the ServiceDesk tool

knowledge base where frequently occurring requests and their solutions as well
as FAQs can be categorized and stored

solution or FAQ document
abbreviation for Frequently Asked Question

either a ticket marked in HelpMatics™ for the knowledge base and transferred
into the knowledge base or a solution document newly created in the knowledge
base

group within the database for controlling access rights
abbreviation for Service Level Agreement
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Appendix

15.1 Knowledge

15.1.1 Complete editorial workflow

Responsibility Process Note
Ticket from HM
New document or new
Knowledge
document
Manager
Expert
Is the incident of
use and in the
competence of the
expert?
Expert
Manager
Manager
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15.1.2 Complete editorial workflow with automatic assignment

Responsibility Process Note
Ticket from HM
New document or new
Knowledge
Document
A
"HCL Notes
Agent'

. Assignment to
Assignment
possible2 expert by agent,
if possible

Manager
Expert
No No
Yes No
Is the incident of
use and in the
competence of the
Expert expert?
Manager
Yes Yes

End of process
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Appendix

15.1.3 Minimum editorial workflow

Responsibility

Process Note
Ticket from HM
or new
Knowledge

Document

Manager
Doesn’t the incident
exist yet and is it of
use?

Manager

COC AG

HelpMatics™
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15.1.4 Bypassing the editorial workflow

Responsibility Process Note

Ticket from HM

- ) or new
ew documen Knowledge

Document

Automatic release of
document

y
End of process
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16 Imprint

COCAG

Product Management HelpMatics™

Gewerbepark Lindach A 12
84489 Burghausen
Germany

Telephone: +49 (0)8677 / 9747 - 0
fax: +49 (0)8677 / 9747 - 199

E-mail: info@coc-ag.de

Internet: www.helpmatics.com

Please note: HCL Notes/Domino ™ is a protected trademark and enjoys the full protection of legal
regulations applying to registered trademarks.

COC AG takes utmost care that the contents of this manual are correct and topical at the time of their
completion. However, COC AG does not assume any warranty for correctness regarding the contents and
completeness and rules out any liability. COC AG reserves the right to change the contents of this manual or
of parts of it or to supplement it without explicitly indicating it, any time. Use and transmission of information
is made at your own risk.
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